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Communications regulation information 

FCC statement 
This equipment has been tested and found 10 comply with the limits for a Class B digital device 
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference lo 
radio or television reception is suspected. 

Radio and television interference 
The equipment described in this manual generates, uses, and can radiate radio-frequency 
energy. If it is nol installed and used properly-Iha! is, in strict accordance with Apple' s 
instructions-it may cause interference with radio and te levision reception. 

This equipment has been tested and found to comply with the limits for a Class B digital device 
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed 
to provide reasonable protection against such interference in a residential installation. However, 
there is no guarantee that interference will not occur in a particular installation. 

You can determine whether your computer system is causing interference by turning it off. If 
the interference stops, it was probably caused by the computer or one of the peripheral devices. 

If your computer system does cause interference to radio or television reception, try to correct 
the interference by using one or more of the following measures: 

• Tum the television or radio antenna until the interference stops. 

• Move the computer to one side or the other of the television or radio. 

• Move the computer farther away from the television or radio. 

• Plug the computer into an outlet that is on a diffe rent circuit from the television or radio. 
(That is, make certain the computer and the te levision or radio are on circuits controlled by 
different circuit breakers or fuses.) 

If necessary, consult an Apple-authorized service provider or Apple. See the service and support 
information that came with your Apple product. Or, consult an experienced radio/television 
technician for additional suggestions. You may find the following booklet helpful: /11te1fere11ce 
Handbook (stock number 004-000-00493-1 ). This booklet, prepared by the Federal 
Communications Commission, is available from the U.S. Government Printing Office, 
Washington, DC 20402. 

IMPORTANT Changes or modifications to this product not authorized by Apple Computer, Inc., 
could void the FCC Certification and negate your authority lo operate the product. 

This product was tested for FCC compliance under conditions that included the use of Apple 
peripheral devices and Apple shielded cables and connectors between system components. It is 
important that you use Apple peripheral devices and shielded cables and connectors between 
system components to reduce the possibi lity of causing interference to radios, television sets. 
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded 
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices, 
contact the manufacturer or dealer for assistance. 
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DOC statement 
DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio 
noise emissions from digital apparatus as set out in the interference-causing equipment standard 
entitled "Digital Apparatus," ICES-003 of the Department of Communications. 

Observation des normes-Classe B Cet appareil numerique respecte Jes limites de bruits 
radioelectriques applicables aux appareils numeriques de Classe B prescrites dans la norme 
sur le materiel brouilleur: "Appareils Numeriques", NMB-003 edictee par le ministre des 
Communications. 

VCCI statement 
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Setting Up Your PowerBook 
• • • • • • 

Follow the steps in this chapter to 

set up your PowerBook 

and to learn about turning your 

computer on and off. 

To set up your computer for the first time, you need the power adapter and 
the power cord that came with your PowerBook. 

Step 1 Plug the power adapter into a grounded outlet 
Plugging in the power adapter recharges the computer's batteries. You should 
plug in the power adapter in case the battery has drained during shipping or 
storage. 

WARNING Use only the power adapter that came with your PowerBook. 
Adapters for other electronic devices (including other portable 

computers) may look similar, but they may damage your computer. 

The only way to disconnect power from your computer is by unplugging the 
power adapter. Make sure the power adapter can be easily disconnected. 

• Plug one end of the power cord into the power adapter and the other end into a three­
hole grounded outlet or power strip. 



WARNING This equipment is intended to be electrically grounded. Your 
PowerBook is equipped with a three-wire grounding plug-a plug that 
has a third (grounding) pin. This plug will fit only a grounded AC 
outlet. This is a safety feature. If you are unable to insert the plug into 
the outlet, contact a licensed electrician to replace the outlet with a 
properly grounded outlet. Do not defeat the purpose of the grounding 
plug! 

Step 2 Plug the power adapter cable into the computer. 

2 Chapter 1 

• Plug the power adapter cable into the power adapter port (marked with the icon = ) on 
the back panel of the computer. 

Power adapter port 



Step 3 Open the display 
• Press the latch and lift up the display. 

Press the latch to release the lid. 

Floppy disk drive 

Position the display at a comfortable viewing angle. You can adjust the angle 
of the display at any time by tilting it towards or away from you. 

Setting Up Your PowerBook 3 



Step 4 Turn on the computer 

4 Chapter 1 

• Press the Power On key (marked with the icon <I) at the upper right of the keyboard to 
turn the computer on. 

Power On key 

[~ 

You should hear a tone when you turn on the computer. It takes the computer 
a mome nt to start up. 

When you see something like this on your screen, the computer is ready to 
use: 

Note: Your screen should look very similar to this picture but it might not 
look exactly the same. 



What to do next 

Problems turning on your computer? 
• The computer made a sound, but you can't see anything on the screen. 

Use the brightness control (marked with the icon ·:c?:·) and contrast control 

(()) until an image appears and the screen is easy to read. 

• Nothing happened when you pressed the Power On key (marked with the icon <J) . 

Make sure the power adapter is firmly connected to both the computer and 
a power source. If the power adapter is plugged into a power strip, make 
sure the power strip is plugged in and turned on. Then try pressing<] again. 

• You see a blinking question mark icon on the screen. 

This icon means that you need to install system software on the computer's 
hard disk. System software includes the programs the computer uses to 
start itself up. You received a set of system software disks in the box with 
your computer. For instructions on installing system software, see 
Appendix A. 

• New Macintosh users: If you have never used a Macintosh computer before, 
go to Chapter 2 now to learn how to use your PowerBook. Then go to 
Chapter 4 for important health and safety instructions. For help turning 
your PowerBook off, or putting your PowerBook to sleep, come back to this 
chapter once you have learned to use your PowerBook. 

• New PowerBook users: If you have used other Macintosh computers but are 
new to the PowerBook, read the rest of this chapter for instructions on 
turning the PowerBook off and putting the PowerBook to sleep. Then go to 
Chapter 2 to learn about using the trackpad and to Chapter 5 to learn about 
using the Control Strip. Make sure you read Chapter 4 for important health 
and safety instructions. 

• Experienced PowerBook users: Go to Chapter 2 to learn about using the 
trackpad, then skim this book for information about your new PowerBook. 
Important health and safety instructions are in Chapter 4. 

Setting Up Your PowerBook 5 



Turning the PowerBook off 
When the PowerBook is off, the computer is not using any power or doing 
any work. The terms shut down and off both refer to this state. 

• If the computer is on, choose Shut Down from the Special menu. 

Clean Up Window 
rnwt1J 'f rnsh ... 

Eject Disk X E 
E:rnse Di~k ,,. 

Restart 

Sleep 

• If the computer is in sleep, wake it by pressing any key on the keyboard 
(except Caps Lock), and then choose Shut Down. 

• If a problem with the computer prevents you from choosing Shut Down, 

you can turn off the computer by holding down the Control, Option, 
~(Command), and Power On (<l) keys at the same time. This turns off 
the power and you will lose any unsaved work. Use this key combination 
only if you cannot choose Shut Down or Restart from the Special menu. 

Putting the PowerBook to sleep 

6 Chapter 1 

When the PowerBook is in sleep, it has a darkened screen, is almost totally 
inactive, but appears to be off. To put the computer to sleep: 

• Choose the Sleep command from the Special menu. (The computer must 
be on in order for you to put it to sleep.) 

Clean Up Window 
E:mptt.l Trnsh ... 

E:j•~c1 Di~k :)(:!: 

Erase Disk ... 

Restart 
Shut Down 

Sleep 

Note: A green light flashes at the top of the display when your computer is 
in sleep. 



Automatic sleep 

If you don't use the computer for several minutes, it goes to sleep 
automatically (unless you change the sleep preferences). This conserves 
battery power. 

To wake the computer, press any key on the keyboard (except Caps Lock). 
The screen will reappear as it was before the computer went to sleep. 

For more information on sleep and automatic sleep, see Chapter 6. 

Restarting a computer that's already on 

You need to restart your computer-turn it off and back on again 
immediately-when you want to make certai n changes to settings, use a 
newly installed system software file, or start up the computer using a different 
disk. 

You also need to restart if you see a "system error" message on the screen 
(i ndicating a temporary software problem). In this case, use the trackpad to 
click the Restart button that appears. 

To restart your computer: 

• Choose Restart from the Special menu. 

Clean Up Window 
E:mpt1.~ ·rrnsh ... 

E:j•~c1 Ui~I< :)~[ 

Erase Disk ... 

Sleep 

When you choose Restart, the computer prompts you to save your work, 
closes all open programs, and restarts itself. 

Choosing Restart does not affect your RAM disk (if you created one) or its 
contents. 
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Learning to Use Your Computer 

Go through the exercises in this 

chapter to learn how to use 

your computer and 

the computer's trackpad. 

Your computer comes with a tutorial that teaches you the basics. The tutoria l 

is divided into two parts: 

• Part 1 You start the Maci111osh Basics tour on your computer, which presents 

the basic skills you need to master. 

• Part 2 After you complete the Macintosh Basics tour, you return to this 

chapter to practice what you learned. You also learn some addi tiona l skills. 

If you've never used a Macintosh computer before, you should complete both 

parts of the tutorial. 

If you are an experienced Macintosh user, you' II want to learn how to use the 
trackpad in the fi rst part of the Macintosh Basics tour. Then you may want to 

look over the rest of this book to learn about special features of this computer. 

As you work with your Macintosh, consul t the Macin tosh Reference book for 

answers to questions about the syste m software that came with your computer. 

IMPORTANT If you need to turn off your computer at any point before 

finishing the tutorial. please see "Turning the PowerBook Off" in Chapter I. 

9 



Part 1 Starting the Macintosh Basics tour 

10 Chapter 2 

Your Macintosh Basics tour is on the hard disk that's inside your computer. To 
take the tour, follow these steps: 

Make sure your computer is turned on. If the screen is dark, try adjusting the 
screen (see "Problems Turning On Your Computer?" in Chapter 1) until you 
see words and small pictures on your screen. 

1 Move your finger on the trackpad to move the arrow pointer around on the screen. 

Place your index finger on the trackpad and your thumb on the trackpad 
button. Don't press the trackpad button yet. 

Move your fi nger across the trackpad, watching the arrow on the screen. 

Notice that the arrow moves in the same direction as you move your finger on 

the trackpad. 

T rackpad T rackpad button 



You use the trackpad to move the pointer on the screen in the same direction 
you move your finger over the pad. The trackpad is sensitive to not only the 
direction you move your finger, but also to how fast you move your finger. 

If you want the pointer to move a short distance across the screen , you move 
your finger slowly across the trackpad. The faster you move your finger 
across the pad, the farther the pointer moves on the screen . 

. ~iP.~ !.~~ .'!~ifl.q. !~~. !~~~~P.~~ 
For best results when using the trackpad: 

• Use your index finger (left or right hand). Use only one finger. 

• Use only your finger on the trackpad. Do not use a pen or any 
other object. 

• If you think that the trackpad needs to be more or less 
responsive to your touch, you can adjust the speed in the 
Trackpad control panel. See ''Adjusting the Trackpad" in Chapter 
7 for help using the 'Irackpad control panel. 

• Extend your PowerBook's elevation feet when it is placed on a 
desktop. This gives your fingers better access to the keyboard and 
makes it easier to use the tip of your finger on the surface of the 
trackpad. 

• Adjust the height of your chair so you are seated comfortably 
and at a safe distance from the desk. For more information, see 
''Arranging Your Work Area and Equipment" in Chapter 4. 

• Sometimes humidity or condensation may cause moisture to 
gather on the trackpad. If this happens, gently wipe the trackpad 
with a clean cloth before you use it. 

Learning to Use Your Computer 11 



2 Notice the Control Strip at the bottom of your screen. 

el Fiie Cdlt lhl•u• Lobel \peclGI CD 0 

The Control Strip ..... 

12 Chapter 2 

The Control Strip is the line of pictures at the lower left of your screen. You' ll 
learn more about the Control Strip in Chapter 5. 

3 Move your finger on the trackpad so that the tip of the arrow is on the tab at the far end 
of the Control Strip. 

4 Being careful not to move your finger on the trackpad, press the button once. 

The Control Stri p closes and on ly the tab appears at the lower l eft of the 

screen. 



5 Move your finger on the trackpad so that the tip of the arrow is on the picture labeled 
"Macintosh HD." 

Make sure the tip of the arrow is over the picture, not over the words 
"Macintosh HD." 

C me Cdll U1eur lnbtil Speclnl CD 0 

,,. .. 

Move the arrow so that it 
is on top of this picture. 

6 Being careful not to move your finger on the trackpad, press the button twice in quick 
succession. (This is called "double-clicking.") 

Now your screen should look like the illustration following step 7. The items 
in the illustration below may not exactly match those on your screen. The 
only ite m you need right now is the Macintosh Basics folder. 

If the screen doesn't look right, try steps 5 and 6 agajn, paying special 

attention to the fo llowing: 

• Make sure the tip of the arrow is touchi ng the picture, not the words 
be neath it. 

• Be sure to press the trackpad button twice. 

• Press twice quickly and be careful not to move your finger on the trackpad 
whil e you press. 

Learning to Use Your Computer 13 



7 Move your finger on the trackpad to place the tip of the arrow on the picture of the folder 
labeled "Macintosh Basics." 

• rne Cdll Ulew Lebel Special CD 0 
Mocln l osh HD 

!l l\MU 39 ,..~dlP .S.21"11 1nllatl., mll3 
re:i Gl m ~ ~ 

•tMMt- S~h .. t 

Move the arrow 
so that it is on 

top of this picture. 

5¥stHl'IF•lottf' M..c .. tj lli40..n 

~ 
0 

1(1\!il 
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lru tri 

8 Being careful not to move your finger on the trackpad, press the button twice in quick 
succession. 

Now your screen should look like the following illustration: 

• me Cdil Ultw lab e l Spetlal CD 0 
Macinl D\h HD 
Maclnlo\h Boslu 

~I l' rtfft\t 39r-e•fllsk 3.sz,.. , .. .. ~i.. 

~ 
J) ~ 

~toll'J .. J•• 
l2I _IQ 

~. 
I ,,. .. 



9 Move your finger on the trackpad so that the arrow is on the picture of the man labeled 
"Macintosh Basics." 

Macintosh$ Basics E!Jii 
3 9 MB in disk 342 r1:hn11.t>lf 

M~Vltosh 8Hk:'S 

10 Press the trackpad button twice in quick succession. 

Now your screen should look li ke the fo llowing picture: 

Macintosh 
Basics 

Welcome to Macintosh B>Sics! I'll be your host throughout this 
tour of the Macintosh. As you work through Macintosh Basics, 
you'll learn what you need to get mned using your M>eintosh. 

Jf you don't see this screen, try again, paying special attention to the 
following: 

• Make sure the Lip of the arrow is touching the picture, not the words 
beneath it. 

• Be sure to press the trackpad button twice. 

• Press twice quickly and be careful not to move your finger on the trackpad 
while you press. 

11 Follow the instructions on the screen and work through the tour. 

When you fini sh the tour, continue with the rest of this chapter. 
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Part 2 Practicing your new skills 

16 Chapter 2 

You should now have completed the Macintosh Basics tour. 

The second part of your training gives you an opportunity to think about 

what you've learned so far and to practice your new skills. 

Reviewing what you've learned 

Before continuing, take a few moments to answer these questions. They will 
help you summarize the information you learned in Macintosh Basics. You 

may want to write (or circle) your answers as appropriate. The correct 

answers are in the next section of this chapter. 

If you have any trouble answering the questions, look in Chapter 3, "Basic 
Ski I ls." 

Question: What is the name of tire area where you do all your work? (Its shown 

be/OHi) 

Answer: ________________ _ 

It mu Cdlt U1ew Lebel Speclnl 



Question: What are pictures on the Macintosh desktop called? Two examples are 
shown be/01'11 

Answer: _________________ _ 

tt m e Cdil 111.-111 Lobel ~peclnl 

Circle the hard disk window in the illustration below. 

tl rue Cdit Ulew Label Special 

Mecln tosh HD 

,,.., 

CD CJ 

What is the name for these 
pictures on the Macintosh 
desktop? 

Learning to Use Your Computer 17 



18 Chapter 2 

Circle the hard disk icon in the illustration below. 

• me ClJll Uiem Lobel Spe clol CD 0 
l Mncln los h HO E!ll 
!JU- 3.,t"llWidur.. JAz~ ..... ,.._., ua'IL 
[fil G: ~ ~ 

<> 

'Sv•t.m row.r Mtoe\"ll OJ.f\ti..no;J "ndMf. Sll'nf!.l•i<I 

~ 

[}_ 
I 
'""' 

Question: Circle the active window on the desktop belo111 How do you make a 
window active? 

Answer: _________________ _ 

• me [dll Ulew Lobel Special CD 0 
Maclnl oo;h 110 
Mocinlosh Ooslu: 

~I l4l'Hr\I. 39tl!WIM 34 2 1"8 ..... ,lob .. M 

of) 
~I 

~ 
~ft•ort>8.tuer 

21 
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Question: Which menu is the Save command in? 

Question: How do you throw an item away? 

Label the parts of this window. 

_!_~-- B. 
Macin t osh HD E!ll 

33 ittms: 42.3 MS 1n disk 

~ 
0 1-c. 

!lJ LJ [Bl ""' 17,[i D. System Foldw M~ 'w'ork Read Me Simplt rex t 1:-it-
!'::' 
0 

E. <>l J ¢'21 -
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Answers to the review questions 
These are the answers to the summary that you completed earlier. 

Question: What is the area called where you do all your work? 

Answer: the desktop 

Question: What are pictures called on the Macintosh desktop ? 

Answer: icons 

Circle the hard disk window in the illustration below. 

Circle the hard disk icon in the illustration below. 

ti: rile Cdlt Ulelu Lobel \ pedal 

Meclnlosh HO 
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Question: Circle the active window shown 011 the desktop be/0111 How do you 
make a window active? 

Answer: by clicking anywhere inside of it 

tl rile CcUt Ulew Lobel Speclnl 

MoclntO$h BHIO 
3cii,...l'\.-. 

• Question: Which menu is the Save command in? 

Answer: the Ftle menu 

Question: How do you throw an item c11vay? 

Answer: by dragging it to the Ii-ash and choosing Empty 'Ti-ash flvm the Special 
menu 

Label the parts of this window. 

l 
A The close box _c B The title bar 

II~ Macintosh HD 0; 
33\t.ms 42-3 M8 In dtSlc 34.5 l"S fY~ll<iblt 

~ m ~ or-
D r 

[ 

h---S\jst.m f'oldtr Ml} W'ork Rud M• S1mpl~ Ttx1 

C. A scroll anvw 

D. Tiie scroll bar 
'O 

IOI __l¢ '2lr- E. The size box 
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Practice session 

Now you can pract ice what you learned in Macintosh Basics. You' II be 

practicing your skills using real programs that came with your computer, 
rather than the sample ones in Macintosh Basics. 

IMPORTANT If you get lost at any point during the practice session, or if 
something unexpected happens, please turn to "Clues on Your Screen" in this 
chapter. These tips will help you get back on track. 

1 : Creating a new document 

1 Open the hard disk icon and then open the Simple Text program, as shown below. 

iD Un II tied 

22 Chapter 2 

1 Double-click the hard disk 
icon to open it. 

2 If a window with the name 
of your hard disk doesn't 
appear, click the disk icon 
again twice. 

3 To open the Simple Text 
program, double-click the 
Simple Text icon. 

When the Simple Text program 
opens, a window appears with 
"Untitled" in the title bar. This is 
your blank document. 



2 Use the keyboard to type a few lines of text into the blank document. 

ID Untltle<I Elii 
This Is e prectice file. I em typing just to find out whet ll feels -0 
like. If I meke e mtsteke, I cen use the Del ete key to beck up end 
erese It 

Type text in the blank document. 

It doesn't matter what you type. ff you make an error, press the Delete key to 
backspace over the incorrect letters, th en retype. 

3 Choose the Save command from the File menu to save your new document. 

When you save a document, you are storing it on the hard disk. You need to 
save every document you create. If you don't save it, the document is lost 
when you turn off the computer. 

N(m• :)(:N 

01>en ... :)[<0 

Close 3C W 

Page Setup ... 
Print... :M: P 

Quit 3CQ 

Choose Save from 
the File menu. 

A box li ke the one in the next step appears, with the word "Untitled" near the 
bottom. This box lets you name and save your document. 
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4 Don't click anywhere. Just type the name "Practice File." Then click the button labeled 
Save. 

Type the name of 
your document to 
replace "Untitled." 
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I= Macintosh HO • I = Macintosh HO 
~L=,=11=~1~11l=M=t=, ========~~~""' 

D Sys tem Folder 
<ll Slm111<ileut Desktop J 

New L.J J 

I- [ Cancel 

i'=-=========!.~=i [! Snue )J 

I ®tJ oEJ So11e this document os: 

Untitled 

T he name you type should re place the word "Untitled" in the box. If it 
doesn't, place the pointer to the left of the U in "Untitled ," then press the 

trackpad button and drag across the word . Whe n " Untitl ed" is highlighted 
(the text is surrounded with a black box), type the new name. 

!=Macintosh HO• I = Macintosh HO 
IF.'DF;;. B~1~ 11;=,=1I M~•~~=:=~~F,Cil IQ l:Jf~t:I 

D Sys tem Folder 
<ll Slm11i<fl<mt [ Desk top ) 

[ New L.J ) 

I- Concel 

hzo So11e 

So11e t his document os: Q 
~lr_ra_c_1 1_ce_r_11_e ____ ~I ®0 of.3 

Click Save to save your 
Practice File on the hard disk. 

After you click Save, a copy of your document is stored on the hard disk in 

your computer. The new name appears in the title bar of the document. 

The name of your document 
appears in the title bar. 

i D Procti ce File E!ll 
This ts n proclice ft le I nm typing just t o find out w hat It feels 0 
like If I make o mtstoke, I con use the Delete key t o back up ond 
erase It 



5 Choose Quit from the File menu to quit the Simple Text program. 

New :)(:N 

D!)P(L,. :)(:!) 

Close acw 
S <HI (~ :)(: S 
Saue As ... 

Page Setup ... 
Print ... a& P 

Choose Quit from the File 
menu to quit your program. 

The SimpleText program closes, along with your document. 

6 Check for the file you saved in the hard disk window. 

You should see the icon for the document you saved in the hard disk window. 

If your Practice File icon doesn't appear, it may be in a hidden part of the 
window. You can scroll through the window to find the icon_ if you need to. 

10~ Moclntosh HD liii!iiiiE!JI 
30items 42.1 M8indislc 34.7MB• 

Le] 
5'js-ttm Fo5dtr 

fl . . 
Rud Mt 

Here's the new file---;,___ ___ _..--. 

If you don't see your document, 
click the arrows to scroll through 
the window. 

you just created. 

That's the end of the first exercise. You may want to take a break before you 
continue. 
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2: Storing your work inside a folder 
You can organize your work on the Macintosh by creating folders and storing 
your documents inside of them. 

1 Choose New Folder from the File menu. 

A folder icon named "untitled folder" appears in the active window on the 
desktop . 

• o ==i Mncintosh HD ~0i 

31 tttms 42.1 MJ Vl dlsk 34 .6 MB .. 

~ 
S.., sltm Foldtr 

iii!il-+Ht-A new folder icon appears 

II ~ 
in the hard disk window. 

Rud Mt Simplt Text 

Without clicking anywhere, type "My Work" to name the folder. 

Notice that the words "untitled folder" are highlighted and boxed. That means 
the name you type will replace these words. 

ID!iiliil Macintosh HD =0!! 
3 1 itHns 42.2 MB in dtsk 34.6 MS .. 

~ 
St,isttm Foldtr 

iii 
Rud Mt 

f;.l----1~;.,..:, :; 1--The new name of your 
~ !I::' folder appears here. 

Simplehxt @ 

8 
Pr~tiet Fil+ 



3 Drag the Practice File into the folder named "My Work." 

Move the pointer to the Practice File. Then press and hold down the button 
while you move the Practice File to the folder named "My Work." When the 
tip of the pointer is on the folder icon and the folder becomes highlighted, 
release the button. 

iiD~ Moclntosh HO - 0 1 
31 itt ms 42 .2 MS In di sk 34.6 MS • 

Li] 
St,ist tm F'oldt r 

~ 
~ 

Rud Mt 

--i-+-- Move the pointer to this icon. Then press 
and hold down the button while you move 
this icon to the folder named "My Work." 

4 Open the folder named "My Work." 

You open a folder the same way you open any icon: double-click it, or click it 
once and choose Open from the File menu. 

The "My Work" folder window opens, and you can see your Practice File. 

Macintosh HO 
30 items 42.2 MB in disk 34 .6 MB•' 

. ~D~ My work ~0~ 
1 item 42.2 MB in disk 34.6 MB a 

You have now completed the second practice exercise. You may want to take a 
break before continuing. 
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3: Throwing an item away 

As you work, you will want to remove items you no longer need from the 
hard disk. You remove items by throwing them into the Trash. In this exercise, 
you will throw the Practice File into the Trash. 

1 If the Macintosh HD window is not already open, open it by double-clicking the 
Macintosh HD icon. 

2 If the folder named "My Work" is not already open, open it. 

Note: If you can' t see the Trash icon (which should be in the lower- right 
corner of your screen) move the windows so that the Trash icon is visible. To 
move a window, place the pointer in the window's title bar (the stripes at the 
top of the window), and drag the window. 

3 Drag the Practice File to the Trash icon. 

Place the pointer on the Practice 
File icon. Press and hold down 
the button as you move the 
pointer to the Trash icon. 
When the tip of the pointer is on 
the Trash icon and the Trash 
icon becomes highlighted, 
release the button. 

When you place an item in the Trash, it is not immediately removed from 
your disk. The Trash icon bulges to show you that the Practice File is in the 
Trash, but still on your disk. 



4 Open the Trash icon (by double-clicking it) to see your Practice File there. 

Your Practice File is 
in the Trash. 

5 Open the Special menu and choose Empty Trash. 

A dialog box appears. The computer displays a dialog box when it asks you to 
confirm an action. You must click OK or another button in the dialog box 
before you can take any other action. 

6 ClickOK. 

The Trash is emptied and the Trash icon returns to normal. 

The Empty Trash command permanently removes from your disk anything 
that is in the Trash. Always be sure that you know what you're removing 

before you choose Empty Trash. 

Note: You can get an item back from the Trash by moving its icon back to 

your disk before you choose Empty Trash from the Special menu. After you 
choose Empty Trash, you can't recover items you've thrown away. 

You have completed all of the practice exercises. Before you continue with 
your own work, you might want to skim Chapter 3, "Basic Skills:' for a 
summary of basic ski lls that you' ll need as you work. 
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What's next? 

The best way to get experience working with your computer is to begin to do 
your own work. You may have already purchased application programs to 
work with. You'll need to install these on your hard disk. Be sure to read the 
manuals that came with your application programs for information on how to 
install them. 

Clues on your screen 

30 Chapter 2 

As you work, check the screen frequently for these important clues about 
where you are. If you are lost or if something unexpected happens, ask 
yourself these questions: 

Is this the right program? 

Check the menu bar. If it looks like this example, you are in the Finder. If 
any of these menu names are diffe rent or missing, you are in another 
program. To get back to the Finder, dick anywhere on the desktop pattern. 

The Finder menu bar 



Is the correct window active? 

Usually only the active window is affected when you type or use a menu. The 
active window has stripes in its title bar. To make a window active, click 
anywhere inside it. 

Is the icon or text you want to work with selected? 

Commands you choose in menus usually work only if an icon or some text is 
selected. Check the item you want to work with to make sure it's highlighted 
(which means it's selected). 

Is it best to start over? 

If you get stuck or lost as you practice on the computer, try one or more of 
the following remedies and then start the practice session over agai n: 

• If an unwanted or confusing window is on your screen, click the Close box 
in the upper-left corner of the window to close it. 

• If an unwanted window or box contains a Cancel button, click it. 

• If the File menu contains the word Quit, choose it. 

• If you're really stuck, res tart your computer. 

To restart, click the desktop (the background pattern on your screen), and 
then choose Restart from the Special menu . This turns the computer off 
and then back on. When you restart a computer, problems often clear up. 
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Basic Skills 
•••••• 

Refer to this chapter for Information 

on basic Macintosh skills. 

This section provides information on the following basic skills: 

• Working with icons 

• Working with windows 

• Working with documents 

• Working with disks 

• Organizing your desktop 

• Working with menus 

• Keyboard shortcuts in the Finder and in directory dialog boxes 

• Using special keys on the PowerBook keyboard 
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Working with icons 
An icon is a picture that represents something else. 

ti: fillfl Cdlt Ulew Label Special 

Macintosh HD This icon represents 
the hard disk. 

These icons 
represent folders, l~===============--..J 

programs, and 
documents that 

are stored on the 
hard disk. 
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Selecting icons 

To do this 

Select the icon 

Deselect an icon 

Select multiple icons 

Deselect an icon in a 
group of selected icons 

Select multiple icons 
that are near each other 

Select a list or partial 
list of icons 

Follow these steps 

Click the item. 

Click anywhere except the selected icon. 

This icon represents 
the Trash. 

While holding down the Shift key, click each icon. 

While holding down the Shift key, click the icon. 

1. Place the pointer at one corner of a group of icons. 
2. Press and hold down the button. 
3. Drag diagonally to select the icons, then release the 

button. 

1. Place the pointer to the left of the top icon or the bottom icon. 
2. Drag up or down the list, releasing the button when the items 

are selected. 



Copying icons 

To do this 

Copy a file onto 
another disk 

Copy an icon on 
the same disk 

Opening icons 

To do this 

Open an icon 
(disk, folder, etc.) 

Moving icons 

Follow these steps 

Drag the icon of the file to the icon of the other disk 
or to an icon or window that belongs to that disk. 

1. Click the icon to select it. 
2. Choose Duplicate from the File menu, or press ~-D. 
3. If you wish, rename the new icon and drag it to a new location. 

You can also make a copy by holding down the Option key while 
you drag the icon to another folder or window. 

Follow these steps 

1. Click the icon. 
2. Choose the Open command from the File menu. Or double-click 

(click twice quickly) on the icon. 

To do this Follow these steps 

Move an icon on a disk Drag the item to the location you want. 

Naming icons 

To do this 

Select text in an 
icon's name 

Rename an icon 

Follow these steps 

Click the icon name (not the icon itself). 

1. Select the text under the icon. 
2. Type the new name. 
3. Press the Return key. 
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Removing items from the disk and retrieving them from the Trash 

To do this 

Erase or remove 
an item from a disk 

Retrieve an item 
from the Trash 

Follow these steps 

1. Drag the icon to the Trash. 
2. Choose Empty Trash from the Special menu. 

1. Open the Trash icon. 
2. Drag the icon out of the Trash (and into the disk or folder window 

where you want to store it). Or, choose Put Away from the File menu 
to return the icon to its original place on a disk. 

Working with windows 
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A window opens when you double-click an icon. A window usually shows 
you what's inside an icon. 

Click the close box Click the zoom box 
to close a window. to resize a window. 

= Macintosh HD 

This is a window showing you 
what's on the the hard disk 

named "Macintosh HD." 

Drag the size box to 
enlarge or reduce the 

window. 

Click the scroll arrow to view 
contents that you cannot see. 

Move the scroll box up or down 
to view the contents of a window 
that you can't see. The gray in 
the scroll bar indicates that there 
are contents of the window that 
you cannot see. 



Viewing the contents of a window 

To do this 

View the contents 
of a window by name, 
date, size, or kind 

View the contents of the 
window in outline form 

Follow these steps 

1. Pull down the View menu. 
2. Choose the menu item that corresponds to the way you want to 

view the contents of the window. 

1. Choose any list view from the View menu (any view except the 
icon and small icon views). 

2. Click the triangle next to a folder name to display or hide the contents 
of the folder. 

Making a window active 

To do this Follow these steps 

Make a window active Click anywhere inside the window or double-click its icon. 

Opening higher level folders or disks 

§0 
Name 

D Color 

D Date& Time 

D Easy Access 

D File Sharing Monitor 

D General Contr ols 

D Keyboard 

D Labels 

1 Hold down the 31: key as you press 
the title of the active window. 

2 Drag to choose a higher-level folder 
(or disk) and then release the button. 

=Macintosh HD 
36K contro 1 pane 1 

12K control panel 

SK control panel 

23K control panel 

9K control panel 

3K control panel 
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Working with documents 
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Opening and closing a document 

To do this 

Open a document 

Close a document 

Follow these steps 

1. Click the icon for the document. 
2. Choose the Open command from the File menu. Or double-click 

(click twice rapidly) on the icon for the file. 

Choose Close from the File menu. Or click the close box of the 
document window. 

Opening a document from within a program 

To do this Follow these steps 

Open a document 
when you are working 
in an open program 

1. Choose Open from the File menu. 
2. Click the name of the document. (The 

illustration shows how to find a folder that you might not see.) 
3. Click the Open button. 

Press this label to open a pop-up 
menu of folders and disks 

1 
1 

[a M_y_ work •] 

Lll•ir.IU ll•ilm '1IJ I <r = Moclntosh HD 
D Sandy's memo "t" 

[ l:j<H t l 
[ Desk top l 

n Open D 
to ( Con eel l 

The documents in the disk or 
folder you choose are listed here. 



Saving and naming documents 

To do this 

Save and name a 
document 
for the first time 

Save the document 
under another name 
(Save as) 

Follow these steps 

1. Choose the Save command from the File menu. 
2. Type a name for the document. 
3. Click the Save button. 

1. Choose the Save As command from the File menu. 
2. Type a new name for the document. 
3. Click the Save button. 

Choosing a folder when saving a document 

To do this Follow these steps 

1. Choose Save or Save As from the File menu. Save a document while 
working in a program 2. Click the name of the folder you want to save your document in. 

(The illustration shows how to find a folder that you might not see.) 
3. Click Open to open the folder. 
4. Name your document. 
5. Click the Save button to save the document inside the folder. 

Press this label to open a pop-up 
menu of folders and disks. 

c:> Macintosh HD 

Desktop 

New CJ J 

Saue this docu en t as: ( Cancel J 

[( Saue )J Untitled 

The documents in the disk or 
folder you choose are listed here. 
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Working with disks 
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Preparing a new floppy disk for use 

See "Using Disks" in the Macintosh Reference book. 

Ejecting a floppy disk 

To do this Follow these steps 

Eject a floppy disk Drag the disk's icon to the Trash. 

Copying the contents of a disk 

To do this 

Copy the entire contents 
of one floppy disk onto 
another floppy disk 
(with one disk drive) 

Copy an entire floppy 
disk onto a hard disk 

Copy items from a hard 
disk onto a floppy disk 

Follow these steps 

1. Insert the original floppy disk into the floppy disk drive. 
2. Drag the floppy disk icon to the hard disk icon. (The floppy disk 

contents appear in a folder on the hard disk.) 
3. Drag the floppy disk icon to the Trash. 
4. Insert the floppy disk that you want to copy to. 
5. Drag the icon of the newly created folder to the floppy disk icon. 
6. Drag the floppy disk icon to the Trash. 

1. Drag the icon for the floppy disk to the icon for the hard disk. 
(The floppy disk contents appear in a folder on the hard disk.) 

1. Select the items you want to copy. 
2. Drag the selected icons to the floppy disk's icon or window. 

Copy items from a floppy 1. Select the items you want to copy. 
disk onto a hard disk 2. Drag the selected icons to the hard disk's icon or window. 



Erasing the contents of a disk 

To do this 

Erase the entire 
contents of a floppy disk 

Organizing your desktop 

Follow these steps 

1. Insert the disk you want to erase into a disk drive. 
2. Click the icon of the disk you want to erase. 
3. Choose Erase Disk from the Special menu. 
4. Respond to the messages on your screen by clicking the 

appropriate buttons. 

Creating a new folder 

To do this 

Create a new 
folder 

Follow these steps 

1. Choose New Folder from the File menu. 
2. Type a name for the folder. 
3. Press the Return key. 

Placing an icon inside a folder 

To do this 

Place an icon 
inside a folder 

Follow these steps 

1. Drag the icon to the folder where you want to store it. 
2. Release the button when the folder icon becomes highlighted. 
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Working with menus 
To choose an item from a menu: 
1 Point to the menu. 
2 Press and hold to pull down the menu. 
3 Drag to the item you want to choose. 
4 Release the button when the command is 

highlighted. 

This is the Help menu, 
which you use to display 
information about items on 
the screen. 

Dimmed commands ___ __ 

This is the Application menu, 
which you use to see which 
programs are open. 

are not available. 

Keyboard shortcuts in the Finder and in directory dialog boxes 
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Key Action 

Up, Down, Left, Selects the next item in the direction of the arrow 
or Right Arrow key 

Tab key Selects the next item alphabetically (except in a directory dialog box and 
the Chooser) 

Character key (a, b, c ... ) Selects the first item whose name begins with that character (or the 
character following closest to it in the alphabet) 

x-Down Arrow Opens the selected icon 

X-Option- Down Arrow Opens the selected icon and closes the current folder 

x-Up Arrow Opens the folder that contains the current folder 

X-Option-Up Arrow Opens the folder that contains the current folder and closes the current 
folder 

Return or Enter In a dialog box: the same as clicking the button with the bold outline 

In the Finder: selects the selected icon's name for editing or saves the 
edited name 



Caps lock ke 

Control key 

Special keys on the PowerBook 520, 520c, 540, and 540c keyboard 

Escape key Function keys Delete key Power on key 

Option key :tc (Command) key Enter key Arrow keys Return key Shift key 

Arrow keys 

Caps Lock key 

3€ (Command) key 

Control key 

Delete key 

Enter key 

Escape key 

Function keys 

Option key 

Power On key 

Return key 

Shift key 

Tab key 

Move the insertion point, as an alternativa to using the pointing device. 
In some programs, the arrow keys have other functions. 

A locking Shift key for letters only (numbers and symbols aren't affected). 

Works in combination with other keys as an alternative to choosing a menu 
command. 

In combination with other keys, provides shortcuts or modifies actions. 

Deletes selected material, or the character to the left of the insertion point. 

In a dialog box, pressing Enter is the same as clicking the outlined button. 
In some programs, confirms information you have provided. 

The function of this key depends on the program you're using. 

Some programs allow you to use function keys to give commands. You 
can assign commands or action sequences to function keys with utility 
programs. 

In combination with other keys, produces special characters or modifies 
actions. 

Turns on the computer. 

Moves the insertion point to the beginning of the next line. In a dialog box, 
pressing Return is the same as clicking the outlined button. 

Produces capital letters (or the upper character on the key). 

Moves the insertion point to the next stopping place (such as a tab stop or 
data field). 
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Refer to this chapter for important 

health-related information 

and safety tips. 

Health, Safety, and Maintenance Tips 
• • • • • • 

Important care and safety instructions 
For your own safety and that of your equipment, read and follow all the 
instructions in this section. Keep these instructions available for reference by 
you and others. 

Warning 
• Electrical equipment may be hazardous if misused. Operation of this 

product, or similar products, must always be supervised by an adult. Do not 
allow children access to the interior of any e lectrical product and do not 
permit them to handle any cables. 

• Do not use the computer in or near water. 

• Do not use cables that are frayed or otherwise damaged. Hold a cable by its 
connector (the plug, not the cord) when connecting or d isconnecting it. 

• Always handle batteries carefully. 

• Do not drop, puncture, mutilate, or burn the computer or battery. 

• Recharge batteries only as described in this manual and only in ven ti lated 
areas. 

• Transport batteries either inside the computer or with the protective slider 
covering the battery contacts. 

45 



46 Chapter 4 

• Do not short-circuit the battery terminals (that is, do not allow a metal 
object such as a paper clip or key chain to touch the terminals). Doing so 

may cause an explosion or a fire. 

Caution 
• If you have a problem with your compute r and nothing in the computer 

ma nuals solves the problem, take the computer to your Apple-authorized 
dealer or service provider. Attempting to repair the computer yourself may 

void the limited warranty. 

• Do not move the computer when you can hear its hard disk spinning. 
When you put the computer to sleep, wait until the screen is blank before 
moving the computer. 

• Never force a connector into a port. Make sure that the connector matches 
the port and that it's right side up. If the connector and port do not join 
easily, they do not match. 

• Do not use the computer in wet or dusty environments. 

• Keep dirt and liquids away from the ports on the back panel, the keyboard, 

and the trackpad. If you spill any food or liquid onto the computer, shut it 
down immediately and unplug it before cleaning up the spi ll. Depending 
on what you spilled and how much got into the computer, you may have to 

bring the computer to an Apple-authorized service provider for cleaning. 

• Do not touch the screen with any sharp o r pointed objects. 

• Use on ly the battery supplied with your computer. Batteries designed for 
other portable computers may look similar, but they may not work with 
your computer and may damage it. 

• When recharging the battery, use on ly the power adapter supplied with 
your computer. Adapters designed for other electronic devices may not 
work with your equipment and may dam age the computer or the recharger. 

• Do not leave batteries in ho t locations (such as the trunk of a car). 



Important 
• Use the computer only in environments where the temperature range is 

between 50°F/10°C and 104°F/40°C. 

• Do not expose the computer to very low (less than -13°F/- 25°C) or very 
high (more than J40°F/60°C) temperatures. 

• If the computer has been in a cold place for several hours, Jet it warm up to 
room temperature before you use it. 

• Clean the computer's outside surfaces with a damp (not wet) cloth. Clean 
the screen with soft, lint-free paper or cloth and a mild glass cleaner. Do 
not spray the glass cleaner d irectly onto the screen. 

Caring for batteries 
• Always handle batteries carefully. 

• Do not short-circui t the battery termi nals (that is, do not touch both 

terminals with a metal object). Doing so may cause an explosion or a fire. 

• Do not drop, puncture, disassemble, mutilate, or incinerate the battery. 

• Recharge batteries only as described in this manual and only in ventilated 
areas. 

• Do not leave batteries in hot locations (such as the trunk of a car). 

• Do not leave a battery in your computer for longer than a week without 
plugging in the power adapter. 

• Do not leave a battery in storage for longer than 6 months without 
recharging it. 

• Take dead batteries to an Apple-authorized service provider for recycling or 
proper disposal. The batteries contain hazardous chemica ls and should not 
be thrown out with household or office trash. 
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Health-related information about computer use 
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Muscle soreness, eye fatigue, and other discomforts and injuries sometimes 

associated with using computers can occur from performing any number of 
activities. In fact, misuse of the same muscles during multiple activities can 
create a problem that might not otherwise exist. For example, if you engage 
in nonwork activities that involve repetitive stress on the wrist-such as 

bicycling-and also use your computer's keyboard improperly, you may 
increase your likelihood of developing wrist problems. Some individuals 
are at greater risk of developing these problems because of their health, 
physiology, lifestyle, and general exposure to stress. Work organization and 
conditions, such as workstation setup and lighting, also play a part in your 
overall health and comfort. Preventing health problems is a multifaceted task 
that requires careful attention to the way you use your body every hour of 
every day. 

The most common health effects associated with using a computer are 
musculoskeletal discomfort and eye fatigue. We'll discuss each area of 
concern below. 

Musculoskeletal discomfort 

As with any activity that involves sitting for long periods of time, using a 
computer can make your muscles sore and stiff. To minimize these effects, set 
up your work environment carefully, using the guidelines that follow, and take 

frequent breaks to rest tired muscles. To make working with your computer 
more comfortable, allow enough space in your work area so that you can 
change position frequently and maintain a relaxed posture. 

Another type of musculoskeletal concern is repetitive stress injuries (RSls), 
also known as cumulative trauma disorders (CTDs). These problems can 
occur when a certain muscle or tendon is repeatedly overused and forced into 
an unnatural position. The exact causes of RSis are not totally understood, but 
in addition to awkward posture, such factors as the amount of repetition, the 
force used in the activity, the individual's physiology, workplace stress level, 
and lifestyle may affect the likelihood of experiencing an RSI. 



RSis did not suddenly arise when computers were invented; tennis elbow and 
writer's cramp, for example, are two RSis that have been with us for a long 
time. Although less common than other RSis, one serious RSI discussed more 
often today is a wrist problem called carpal tunnel syndrome, which may be 
aggravated by improper use of computer keyboards. This nerve disorder 
results from excessive pressure on the median nerve as it passes through the 
wrist to the hand. 

This section offers advice on setting up your work area to enhance your 
comfort while you use your computer. Since the effects of repetitive 
movements associated with using a computer can be compounded by those 
of other work and leisure activities to produce or aggravate physical problems, 
proper use of your computer system must be considered as just one element 
of a healthy lifestyle. 

No one, of course, can guarantee that you won't have problems even when you 
follow the most expert advice on using computer equipment. You should 
always check with a qualified health specialist if muscle, joint, or eye 
problems occur. 

Eye fatigue 

Eye fatigue can occur whenever the eyes are focused on a nearby object for a 
long time. This problem occurs because the eye muscles must work harder to 
view an object that's closer than about 20 feet (6 meters). Improper lighting 
can hasten the development of eye fatigue. Although eye fatigue is annoying, 
there's no evidence that it leads to permanent damage. 

Whenever you're engaged in an activity that involves close-up work-such as 
reading a magazine, doing craft work, or using a computer-be sure to have 
sufficient glare-free lighting and give your eyes frequent rest breaks by 
looking up and focusing on distant objects. Remember to have your eyes 
examined regularly. 

To prevent discomfort and eye fatigue: 

• Arrange your work space so that the furniture is properly adjusted for you 
and doesn't contribute to an awkward working posture. 

• Take frequent short breaks to give your muscles and eyes a chance to rest. 
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Arranging your work area and equipment 

The suggestions in this section can help you work more comfortably with 
your computer. 

Chair 

• An adjustable chair that provides firm, comfortable support is best. Adjust 
the height of the chair so your thighs are horizontal and your feet flat on 
the floor. 

The back of the chair should support your lower back (lumbar region). 
Follow the manufacturer's instructions for adjusting the backrest to fit your 
body properly. 

Keyboard and trackpad 

• When you use the keyboard and trackpad, your shoulders should be 
relaxed. Your upper arm and forearm should form an approximate right 
angle, with your wrist and hand in roughly a straight line. 

• You may have to raise your chair so your forearms and hands are at the 
proper angle to the keyboard. If this makes it impossible to rest your feet 
flat on the floor, you can use a footrest with adjustable height and tilt to 
make up for any gap between the floor and your feet. Or you may lower 
the desktop to eliminate the need for a footrest. Another option is to use a 
desk with a keyboard tray that's lower than the regular work surface. 

• Use a light touch when typing or using the trackpad and keep your hands 
and fingers relaxed. When using the trackpad, avoid rolling your thumbs 
under your palms. 



Some computer users may develop discomfort in their hands, wrists, or arms 
after inte nsive work without breaks. If you begin to develop chronic pain o r 
discomfort in your hands, wrists, or arms, consult a qua lified health 
specialist. 

• Change hand posit ions often to avoid fatigue. 

• If you prefer, you can adjust the a ngle of the keyboard by lowering the legs 
until they snap into position. 

The back of the keyboard is slightly elevated when the legs are in use. 
Otherwise, the keyboard is level. 

Mouse 

• If you use an external mouse, position the mouse at the same he ight as 
your keyboard. Allow adequate space to use the mouse comfortably. 

Built-in display 

• Adjust the angle of the display to minimize glare and reflections from 
overhead lights and windows. 

• You may need to adjust the brightness and contrast of the screen when you 
take the computer from one work location to another, or if the lighting in 
your work area changes. 
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External monitor 

If you use an external monitor, this suggestion may be helpful. 

• If possible, arrange the monitor so the top of the screen is slightly below 
your eye level when you're sitting at the keyboard. The best distance from 
your eyes to the screen is up to you, although most people seem to prefer 
18 to 28 inches ( 45 to 70 cm). 

Avoiding fatigue 
• Change your seated position, stand up, or stretch whenever you start to feel 

ti red. Frequent short breaks are helpful in reducing fatigue. 

• Al low adequate workspace so that you can work comfortably. Place papers 
or other items so you can view them easily whi le using your computer. A 
document stand may make reading papers more comfortable. 

• Eye muscles must work harder to focus on nearby objects. Occasionally 
focus your eyes on a distant object, and blink often while you work. 

• Clean your screen regularly. Keeping the screen clean helps reduce 
unwanted reflections. 

What about electromagnetic emissions? 

There has been recent public discussion of the possible health effects of 
prolonged exposure to extremely low frequency (ELF) and very low 
frequency (VLF) electromagnetic fields. Such fields are associated with 
electromagnetic sources such as television sets, electrical wiring, and some 
household appliances-as well as computer monitors. 

Apple has reviewed scientific reports and sought the counsel of government 
regulatory agencies and respected health organizations. Based on the 
prevailing evidence and opinions, Apple believes that the electric and 
magnetic fields produced by computer monitors do not pose a health risk. 
In response to those customers who wish to reduce their exposure to 
electromagnetic fie lds, Apple has lowered the emission levels of its products. 



The Control Strip 

This chapter describes working with 

the Control Strip, the line of modules 

at the bottom of your screen. 

•••••• 

What is the Control Strip? 

Close Box 

When you first turn on your PowerBook, a line of sma ll pictures appears in 
the lower left of the screen. This is called the Control Strip. Each picture in the 
Control Strip is called a module. 

The Control Strip is a quick and easy way to monitor and update your 
PowerBook's power management options. For instance, you can monitor the 
battery charge level and the amount of work time left on your battery. You can 
also adjust such options as File Sharing and sound volume. 

Scroll arrows let you view 
Control Strip modules 
that are not visible. 

Apple Talk 
Switch 

~ 11111111100~ • CS3) 3:21 • 

Battery Monitor 

The Control Strip may look slightly different depending on the options on 
your PowerBook. 

To get a description of each module in the Control Strip, pull down the Help 
menu, choose Show Balloons and point to the modules one at a time. 

53 



How does the Control Strip differ from control panels? 

Many features in the Control Strip work the same way as control panels. For 

the most part, however, control panels offer more options. The Control Strip 
gives you an easy way to access the features you use most often. You can still 
use the control panels anytime to fine-tune your settings. 

Closing, opening, and resizing the Control Strip 
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Closing the Control Strip 

The Control Strip appears on the desktop until you close it. You can close the 
Control Strip one of two ways: 

[)-1 Click the tab at the end of the Control Strip. 

§--2 Click the close box at the beginning of the Control Strip. 

The Control Strip appears on top of application programs. When you close 
the Control Strip, only the tab appears at the edge of the screen. 

Opening the Control Strip 

To open the Control Strip: 

• Click once on the tab. 

The Control Strip opens. 



Resizing the Control Strip 

You can shorten or lengthen the Control Strip to di splay fewer or more 
modules. 

• Click and drag the tab. 

The Control Strip shortens or lengthens as you drag the tab. If you shorten 
the Control Strip and can no longer see all the modu les, use the scroll arrows. 

Hiding the Control Strip 

If you want to hide the Control Strip so it does not appear at al l on the 

desktop: 

1 Choose Control Panels from the Apple (ti) menu, and open the Control Strip 
control panel. 

~ 
Co ntrol Strip 

2 Click Hide Control Strip. 

€[ ! . i 

Control Strip 

0 Show Control Strip 

@Hide Control Strip 

The Control Strip automatically disappears from the screen. 

C lick Show Control Strip in the Control Strip control panel when you want 
the Control Strip to reappear. 

The Control Strip 55 



Moving the Control Strip 

You can drag the Control Strip to the right or left edge of your PowerBook's 
screen or any monitor your PowerBook is connected to. To reposition the 

Control Strip: 

Hold down the Option key and drag the Control Strip by its tab. 

An outline of the Control Strip shows where the Control Strip will move to. 

2 Release the Option key and trackpad button. 

The Control Strip appears in its new position, and remains there until you 
move it again. 

Rearranging the modules in the Control Strip 

You can customize the order of the modules in the Control Strip. To rearrange 
the modules: 

1 Hold down the Option key and drag each module you want to move. 

Release the Option key and trackpad button. 

The module you are moving snaps into place. The modules stay in the new 
order unti l you rearrange them. 

Using the Control Strip 
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Monitoring the charge level of the battery 

Your computer draws power fro m one or two rechargeable batteries. The 
Battery Monitor module in the Control Strip lets you easily monitor the 
battery charge level for each battery in your PowerBook. The total work time 

you get from the batteries depend on how often you use the hard disk, how 
bright the screen is, and other factors. 



The charge level and 
battery icon for the 

left battery are 

The Battery Monitor has four parts: 

• battery icon for each battery 

• battery charge level for each battery 

• total battery consumption rate 

• total estimated work time remaining 

A battery icon appears for 
each battery you use. The estimated work time 

remaining is displayed here 
8 when the batteries are 
y lllllllllDDB •] ~ I 3:21 • powering the computer. ...... __ ........... __ ... ____________ .a.p._.;. ______ _. 

displayed on the left. ____ _. The charge level and 
battery icon for the 
right battery are 
displayed on the right. 

The battery consumption rate is displayed 
here when the batteries are powering the 
computer. Higher rates are to the right. 

The battery charge level, battery consumption rate, and estimated work time 
remaining change depending on the software, hardware, and power saving 
features you use. 

The battery icons change depending on whether the battery is being charged, 
is fully charged, or is powering the computer. Notice that the battery 
consumption rate and the work time remaining are displayed only when the 
computer is being powered by the battery. 

When the battery is powering the 
computer, this icon appears. 

I n 11111111100 i • r mi 1 3,2,. J 

When the power adapter is plugged in and 
charging the battery, this icon appears. 

When the power adapter is plugged in and 0 111111111 • the battery is fully charged, this icon appears. 

The charge level changes as the battery charges. 

When the power adapter is plugged in and the 
~ries are not in the computer, this <:on appears. 
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Customizing the Battery Monitor module 

You can customize the Battery Monitor module to display only the features 
you want. Follow these steps: 

1 Click the Battery Monitor module in the Control Strip. 

The following pop-up menu appears. 

Hide Battery Leve 1 
Hide Battery Consumption 
Hide Time Remainin 

2 Choose the feature you want to hide or show. 

You cannot hide the battery icons. 

Changing the battery conservation settings 

You can control your computer's power consumption using the power 
conservation settings in the Power Settings module. You can also open the 
PowerBook control panel from the Power Settings module. 

1 Click the Power Settings module in the Control Strip. 

A pop-up menu appears. 

Open PowerBook Contro 1 Pane 1 Open the PowerBook control panel if you want to 
use the Custom settings. 

• Better Conservation----+-- Better Conservation gives you longer work time. 
Better Performance Better Performance allows you to work with the 

fewest interruptions. 

2 Choose the feature you want from the pop-up menu. 

The battery conservation settings shown are identical to those shown in the 
Easy View area of the PowerBook control panel. For help with the 
PowerBook control panel, see '~djusting the Battery Conservation Settings" 
in the "Maximizing Work Time" section of Chapter 6. 



Spinning down the hard disk 

The hard disk is one of the main consumers of battery power. To extend work 
time while you are using your battery, it is a good idea to turn off the hard 

disk when you are not using it. This is called "spinning down" the hard disk. 

To spin down the hard disk: 

Click the HD Spin Down module in the Control Strip. 

A pop-up menu appears. 

2 Choose Spin Down Internal Hard Disk. 

T he icon shows that the hard disk is off. 

The hard disk automatically turns itself back on when the computer needs it. 

Putting the computer to sleep 

Putting your PowerBook to sleep when you take a work break, even for a few 
minutes, can give you more work time from your battery. To put your 
PowerBook to sleep from the Control Stri p: 

1 Click the Sleep Now module in the Control Strip. 

A pop-up menu appears: 

2 Choose Sleep Now. 

Note that when your PowerBook is in sleep, a green light flashes at the top of 

the computer's display. 
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Your PowerBook goes to sleep. To wake the computer from sleep, press any 

key on the keyboard. T here are three other ways you put your PowerBook to 

sleep: 

• close the computer's display 

• choose the Sleep command from the Special menu in the Finder 

• hold down the :it: (Command) and Shift keys wh ile you press and release 

the zero (0) key. 

For more information on sleep, see Chapters l and 6. 

Changing the file sharing options 

The icon of the File Sharing module tel ls you whether file sharing is on and 
whether users are connected . 

IQ:3- File sharing is turned off. 

[Q3- File sharing is turned on and no users are connected. 

~ File sharing is turned on and at least one user is connected. 

To change the file sharing option or open the File Sharing Setup control panel: 

Click the File Sharing module in the Control Strip. 

A pop-up menu appears: 

No User--s Connected 

Open Sharing Setup 

Turn File Shar-in On 

2 Choose the file sharing option you want from the pop-up menu. 

For more information on fi le sharing and working on a network, see the 
Macintosh Reference book. 



Changing the sound settings 

Your computer's sound volume can be changed from the Control Strip: 

1 Click the Sound Volume module in the Control Strip. 

A pop-up menu appears: 

7 
6 
5 
4 

•3 
2 
1 
0 

2 Choose the volume setting you want from the pop-up menu. 

For more information on sound, see the Macintosh Reference book. 

Turning an AppleTalk connection on and off 

The icon for the AppleTalk Switch module shows if AppleTalk is on or off. 

I IQ •+-Apple Talk is off. 

It!.. •t-AppleTalk is on. 

Turning AppleTalk off can save you battery power. You can turn AppleTalk on 
and off from the Control Strip. 

1 Click the Apple Talk Switch module in the Control Strip. 

A pop-up menu appears: 

• App le Talk Active 
A le Talk Inactive 
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2 Choose the feature you want from the pop-up menu. 

For more information on AppleTalk and working on a network, see the 

Macintosh Reference book. 

Using video mirroring 

If your PowerBook is connected to a n external monitor you can display the 
same image on the internal display and an external monitor. T his feature is 

call ed "video mirroring." 

When an external monitor is connected to your PowerBook, the Video 
Mirroring module appears in the Control Strip. The icon shows whether 

video mirroring is on or off. 

(I.El ·~Video mirroring is turned off. 

~Video mirroring is turned on. 

You can turn video mirroring on and off from the Control Strip. 

Click the Video Mirroring module in the Control Strip. 

A pop-up menu appears: 

Turn Video Mirrorinq On 

2 Choose the feature you want from the pop-up menu. 

The Video Mirroring module offers exactly the same features as the 
PowerBook Display control panel. For information on using the PowerBook 
Display control pane l, see "Using a Monitor for Presentations" in Chapter 9. 



Power sources 

Power Management 

Read this chapter to learn how 

you can maximize your 

PowerBook's battery life. 

Your computer can draw its operating power from two different sources. 

• Main batteries Your computer includes one or two nickel-metal-hydride 
(NiMH) batteries (depending on the model you have). 1Wo batteries 
provide power for up to 8 hours of work time (depending on the battery 
conservation features you choose). 

Your PowerBook has space for two batteries. You can keep one or two 
batteries in the computer at a time. If you need maximum work time, you' II 
want to keep both batteries in the computer. If you want your Power Book 
to weigh less, you can keep one battery in the computer and purchase a 
separate battery door to cover the battery bay when the battery is not in the 
computer. 

• AC power You can run your computer from any standard electrical outlet by 
plugging in the power adapter. 

The power adapter is really two power supplies in one. It can run your 
computer and charge your batteries at the same time. 

These power sources are described in more detail in the following sections. 
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Responding to low-power messages 
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When the batteries run low, the computer displays a series of low-power 
messages. If you are using two batteries in your PowerBook, the low-power 

messages appear when both batteries are low. 

The work time remaining after you see the first message varies depending on 

how you are using the computer. It's a good idea to act promptly. 

What you should do 

When you see a low-power message, you should do any of the following: 

• Plug in the power adapter, or 

• Save your work and put the computer to sleep, or 

• Replace the empty batteries with charged ones. 

What you should know 

When the first low-power message appears, the screen di ms automatically to 
save power. 

If you continue to work without plugging in the power adapter or changing 
the batteries, the computer displays a second low-power message. 

The second message is followed by a third and fi nal message indicating that 
the computer is about to put itself to sleep. Within a few seconds, the 
computer goes to sleep automatically to protect the contents of RAM. All 
activities are interrupted. It's a good idea to save your work when you see the 
first two low-power messages to make sure you don't lose information. 

If you continue working until the computer goes to sleep automatically, you 
can wake it again as soon as you plug in the power adapter or replace one or 

both batteries with charged batteries. If you take both batteries out of the 
computer, make sure the power adapter is plugged in or you will lose any 
unsaved work. 

If you can't plug in the power adapter, the contents of RAM are retained in 
sleep for about a day (as long as you don't remove the batteries). 



IMPORTANT Recharge depleted batteries as soon as possible. Leaving depleted 
batteries in the computer for longer than 2 weeks (especially in a hot location, 
such as the trun k of a car) may damage the batteries so that they can't 
be recharged. If this happens, you need to replace the batteries. 

Recharging the batteries 

To recharge the batteries in your computer, plug in the power adapter. 

Power adapter port 

The batteries are recharged regardless of whether you are using the computer, 
or the computer is off or in sleep. When the computer is shut down or in 
sleep, both batteries are charged at the same time. 

WARNING Use only the power adapter that came with your computer. 
Adapters for other electronic devices (including other portable 
computers) may look similar, but they may damage your computer. 

A lightning bolt icon appears in the Battery Monitor module in the Control 
Strip when the power adapter is plugged in and a battery is recharging. 

l!WDD11! 
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Recharging two fully depleted batteries takes about two hours with the 
computer shut down or in sleep, or about four hours if you are using the 
computer. 

While the computer is shut down and the power adapter is plugged in, you 
may remove charged batteries from the computer and replace them with 
batteries you want to charge. 

Check to see if a battery is fully charged by looking at the Battery Monitor 
module in the Control Strip. 

Removing or replacing the batteries 

To remove or replace the batteries, follow these steps. 

Save your work, and then choose Shut Down or Sleep from the Special menu. 

You can also plug in the power adapter if you want to keep the computer on 
while you remove the batteries. 

2 Close the dlsplay. 

3 Open the door of the battery you want to remove by slldlng the door in the direction 
indicated by the arrow. 

The door is physically attached to the battery. 



4 Carefully pull the battery you want to change out of its compartment. 

Make sure you move the protective slider that covers the battery contacts so 

the battery contacts are not exposed when the battery is out of the computer. 

5 If you are inserting another battery, slide it into the battery compartment. 

You cannot insert a battery when the protective slider is covering the battery 
contacts. 

6 If you just inserted new batteries, it's a good idea to plug in the power adapter in case 
the batteries are not fully charged. 

IMPORTANT Nickel-metal-hydride (NiMH) batteries contain metals which are 
hazardous when released in the environment. It is inappropriate, and in some 
cases unlawful, to throw batteries away with your household or business trash. 
In stead of throwing away your spent batteries, dispose of them as described 
here. 

• In the United States Return spent batteries to your Apple-authorized service 
provider, who wi ll make sure they are included in Apple's battery recycl ing 

program. 

• Elsewhere Many locations have government or Apple-sponsored collection 
and/or recycling programs for spent batteries. Dispose of spent batteries in 
accordance with the mandatory or voluntary battery collection programs 
in your location. Contact your Apple-authorized service provider for 
information about the recommended disposal procedures in your area. 

WARNING Damaged nickel-metal-hydride batteries may leak small 

amounts of potassium hydroxide. This substance can cause severe burns 
to the skin and eyes. If you touch a damaged battery, immediately wash 
your hands and any other affected areas with water for at least five 
minutes. Do not use soap. 
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Maximizing the life of batteries 
• If your PowerBook has one battery 

If your PowerBook uses one battery, you can maximize the life of your 

battery by discharging and then recharging it completely once every 90 
days. Just use the computer as you normally would, but ignore the low­
power messages that appear on the screen. (Make sure to save your work, 
however.) Whe n the computer goes to sleep automatically after the final 
warning, recharge the battery completely before using it again . 

• If your PowerBook has two batteries 

If you are using two batteries, swap the left and right batteries every month. 

Your batteries will last longer if you recharge them at or slightly below room 

temperature. 

With proper care you can expect your batteries to last for at least a year. If 
you notice that the batteries no longer hold a charge for as long as they 
should, you may need to replace them. 

Maximizing work time 
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Your PowerBook's batteries can provide up to 4 hours of work time each 

before you need to recharge. The actual work time avai lable depends on what 
equipment you're using with your computer and what steps you take to 
conserve power while you work. 

Ways to conserve battery power 

You can see how efficiently your computer is using the batteries by looking at 
the battery consumption rate in the Battery Monitor module of the Control 
Strip. If you are using battery saving features, the meter should point to the 
left. 

Try some of the battery saving features listed below. The more of these 
features you use, the longer work time you get from your batteries. 

• Turn down the screen brightness (-:9:·) whenever possible. At its brightest 
level, the screen consumes about a thi rd of the power your computer is 
using. 



• Keep screen dimming on in the PowerBook control pane l. T he lower 
settings dim your screen automatically if you haven't used the computer for 
a few minutes. 

• Set the Battery Conservation slider in the PowerBook control panel to 
Better Conservation. The rest of this section describes these settings in 

detail. 

• Keep virtual memory turned off in the Memory control panel. 

• If your computer has 8 MB of memory or more, you can use a RAM disk 
as your startup disk to minimize hard disk use. (See "Setting Up a RAM 
Disk" in Chapter 7 for more information.) 

• Quit any program that uses a modem as soon as possible. As long as the 
program is open, your modem is consuming power even if you are not 
using the modem. 

• If you're working near an electrical outlet, plug in the power adapter. 

• If you aren't using the computer, put it to sleep and plug in the power 

adapter. 

Adjusting the battery conservation settings 

The Battery Conservation section of the PowerBook control panel gives you 
several ways to control your computer's power consumption. 

The easiest approach 

Just use the Battery Conservation slider to choose the setting you prefer. 

Choose Control Panels from the Apple (ti) menu, and open the PowerBook control panel 
(or click the Power Settings module in the Control Strip). 

Po'.ver"Book 

The PowerBook control panel opens in Easy View. You can also choose 
Custom View for more detai led options. See "Choosing Custom Options" 
later in this chapter. 
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2 Drag the slider to the setting you want. 

ID Pow erBook 
Eu'l 

B~Utr ~ Bttttr fi='l1 
ConHrvaUon ~ Ptrform.nct D 

OJstom 

There are five settings. Better Performance allows you to work with the 

fewest interruptions. If you can't plug in the computer, Better Conservation 
gives you the longest work time. 

3 Close the PowerBook control panel. 

If you don't use the computer for several minutes (how many depends on 
which setting you choose), it goes to sleep without any action on your part. A 
computer in sleep has a darkened screen and appears to be off, though it is 
still using battery power at a low leve l if the power adapter is not plugged in. 

Note th at a green light fl ashes at the top of your computer's display when the 
computer is in sleep. 

To put the computer to sleep before the automatic sleep setting takes effect, 
choose Sleep from the Special menu or use the Sleep module in the Control 
Strip. 

To wake the computer from sleep, press any key. 

Automatic sleep does not take effect under the following circumstances: 

• You are using an external monitor. 

• AppleTalk is turned on in the Chooser and the power adapter is plugged in. 

• Your computer is connected to a shared disk on the network. 

• Your computer's serial port is in use. 



More about automatic sleep 

The Battery Conservation slider controls three power conservation features: 
system sleep, screen dimming, and hard disk spin-down. 

• System sleep is a state in which your computer uses only the power it needs 
to maintain the contents of RAM (such as any open programs and 
documents, and various control panel settings). You'll see a green light 
flashing at the top of the display when the PowerBook is in sleep. 

• Screen dimming saves battery power by automatically dimming your 
PowerBook's display screen. The display screen is one of the main 
consumers of battery power. 

• Hard disk ~pin-down stops your computer's internal hard disk from spinning 
when it isn't being used. If the PowerBook is in sleep, then the hard disk 
automatically spins down. 

Notice there are five settings on the Battery Conservation slider: 

ID PowerBoolc 

I The five settings in the Battery Conservation slider 
indicate the time it takes for your computer to go to sleep, 
the screen to dim, and the hard disk to spin down. 

The time it takes for each feature to take effect depends on the settings you 
choose. If you drag the slider toward Better Conservation, it takes less time 
for the system to sleep, the hard disk to spin down, and the screen to dim. 

The table indicates how the battery conservation settings correspond to sleep 
times. 

Minutes it takes if you choose 

Conservation Performance 

System sleeps 2 3 6 8 15 

Hard disk spins down 2 3 6 8 

Screen dims 2 3 4 5 
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This section .. . 

... and this section 
of the control panel 

appear whenever 
you click Custom. 

Choosing Custom options 

For more options that affect your computer's power consumption, hold down 

the Option key while you click Custom in the PowerBook control panel. 

ID PowerBook 

MinutH l#\hl : 

~ ~;:n so:::::::::> 
•I • 2 · 4 · 8 · '5Nev•r · I ·2·3· 4 ·S Never 

Hard Disk so· I I I I I I I I ) 

SpV\sOown , 111 1 1 1 1 1 1 

Op I Ions 
18] Allw proce.,or cycli ng - more battery savi OQ• 

Power Conseruot ion 

® Auto I Dottery ..- ) 
0 Monuol . 

Battery Conservation settings 

Click Custom. 

This section of the control panel appears 
only when you hold down the Option key 
while clicking Custom. 

The Battery Conservation slider works as described in the previous section, 
'/\djusting the Battery Conservation Settings." In Custom view, you can also 
use three sliders which control system sleep, screen dimming, and hard disk 
spin-down. (For a description of each feature, see " More About Automatic 
Sleep" in the previous section.) 

Il l PowerBook 

MinutuW1ti1 : 

Svsttm ~ Scr•tn 
SlMps ~ Oims 

• I • 2 •4• 8 • 1SU•nr 
Hard Otsk ~'' ' ''' '', 
SpnsOown'l'JI, I I I I I I I I 

To use the sliders: 

OJstom 

so·· ·· ····· I 1 1111 111 1) 

• 1 • 2 •3•4• :5 Un •r 

1 Choose Control Panels from the Apple (9) menu, and open the PowerBook control 
panel. (Or, use the Power Settings module in the Control Strip.) 

2 Click the Custom button. 
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3 Drag to choose the settings you want. 

The battery conservation slider reflects the changes you make. 

4 Close the PowerBook control panel. 

Processor cycling 

If the computer is not doing anything for a few seconds, it reduces the power 

consumption of its microprocessor. The microprocessor comes back up to 
speed instantaneously when you resume work. This feature is called 
processor cycling. 

Processor cycling conserves battery power. It is highly recommended that you 
work with processor cycling on. But if a program performs very slowly, you 
can turn off processor cycli ng temporari ly. Follow these steps. 

1 Choose Control Panels from the Apple (ti) menu, and open the PowerBook control 
panel. (Or, use the Power Settings module in the Control Strip.) 

2 Hold down the Option key while you click the Custom button. 

3 Click the "Allow processor cycling" checkbox to remove the X. 

Options 
181 Allw proce=r ciich"'I - more battery .. v109s 

4 Close the PowerBook control panel. 

To turn processor cycling back on, click the "Allow processor cycling" 

checkbox again. 

You may notice other effects of processor cycling. For example, if programs 
are working in the background, processor cycli ng may slow them down. You 
may also notice that the Alarm Clock is updated irregularly or that the 
wristwatch pointe r appears more often. These changes do not indicate a 
problem with your computer. 

IMPORTANT To conserve battery power, turn processor cycling off only when 
using programs that it interferes with. Turn processor cycling back on again as 
soon as possible. 
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Power conservation 

Your PowerBook keeps track of what power source you are using and can 
change the power conservation settings accordingly. To control automatic 
power conservation, follow these steps: 

Choose Control Panels from the Apple (ti) menu, and open the PowerBook control 
panel. (Or, use the Power Settings module in the Control Strip.) 

2 Click the Custom button. 

3 Click the Auto button. 

Power Conservation 

® Aut o I Power Adopter -.:.1 [ Default J 
Q Monuol I\' 

4 Select a power source in the pop-up menu. 

Power Conserva tion 
@ Auto 
Q Manuol Power Rdapter 

5 Drag the sliders to the settings you want. 

See the section on Battery Conservation settings for more help. 

6 Close the PowerBook control panel. 

To use the preset power conservation settings, click Default. To turn off 
automatic power conservation, click Manual. 



Customizing and Traveling 
With Your PowerBook 

• • • • • • 

Customizing your PowerBook 

Read this chapter for help using 

custom options on your PowerBook 

and for tips on traveling and 

storing your computer. 

There are several ways you can customize your PowerBook to make your 

day-to-day work easier: 

• Adjusting thetrackpad You can adjust the trackpad and double-click speed in 

the Trackpad control panel. 

• Reconnecting to shared disks If you use your PowerBook on a network to 

connect to shared disks, the AutoRemounter control panel l ets you 

reconnect automatically. 

• Using a RAM disk Using a RAM disk saves you time and battery power. 

When you create a RAM disk, its contents are saved in the System Folder 

when you shut down your PowerBook and then copied back to the RAM 

disk the next time you turn the computer on. 

• Improving the pointer display You can set options to make the pointer more 

visible on the screen. 

• Printing later You can set up documents to print the next time you connect 

to the network printer. 

These features are described in the sections that follow. 
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Adjusting the trackpad 

You can change the trackpad settings so it works better w ith your touch. 

Choose Control Panels from the Apple (el} menu and open the Trackpad control panel. 

[ll] 
Trackpad 

2 Click the tracking speed you want. 

Click a slower setting if you want the pointer to move 
more slowly than your finger on the trackpad. 

Click here if you want _JID~~~~r~ro~c~~~a~d ~~~~ 
P~ Tracklnq 

the pointer to move at r:-1 ® 0 0 0 0 0 ___._ Click a faster setting if you want the 
a constant speed rlf1-l 1 to 1 s1ow rut pointer to move more quickly than your 

relative to the motion L____.1 0oub1e-rnck speed finger on the trackpad. 
of your finger on the nn + + + 
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trackpad. m r- 0 + 0 + ® + 

3 Click the double-clicking speed you want. 

Doub le- Click Speed 

Click here if your 
PowerBook often 

interprets two clicks 
as a double click. 

4 Close the Trackpad control panel. 

+ 
+ 

Click here if your 
PowerBook often 
interprets a double click 
as two single clicks. 



Automatically reconnecting to shared disks 

Your PowerBook disconnects from any shared disks it's connected to when 
you turn it off or restart it, or when it is in sleep. By using the 
AutoRemounter, your PowerBook can reconnect to shared disks automatically 
when you turn it back on (or wake it from sleep). In addition, if you connect a 
hard disk to your PowerBook while it's in sleep, the hard disk appears on the 
desktop when you wake it up. 

1 Choose Control Panels from the Apple (ei) menu and open the AutoRemounter control 

panel. 

AutoRemounter-

2 If you want to reconnect to shared disks only when you wake the computer from sleep, 

click After Sleep. 

If you want to reconnect when you restart the computer as well as after sleep, 

click Always. 

iDl!!!!!!!!!il AutoAemounter ==== 
RHnOOOt Shand 01sks: 

Conn• ct To Db ks ~ : 

0 Automa tical\,I R•mounting 

@ Alw~s Enttrin9 Pu S'W'ords 

3 If you want the computer to ask for your password when you reconnect to shared disks, 
click Always Entering Passwords; otherwise, click Automatically Remounting. 

For better privacy and security, have your computer ask for your password 
before reconnecting to shared disks. 

4 Close the AutoRemounter control panel. 
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Setting up a RAM Disk 

Using a RAM disk saves power because it avoids using the PowerBook's hard 

disk while you are running the PowerBook from its battery. Any files that are 
copied to the RAM disk are saved in the System Folder on the hard disk when 

you shut down your PowerBook. T he next time you start up your PowerBook, 
the files are copied back to the RAM disk automatically. This feature is called 
a persistent RAM disk. It allows you to use your RAM disk without having to 
rebuild it every time you restart your PowerBook. 

The re are two ways to set up a RAM disk, depending on the amount of 
memory in your computer. T he first way allows you to keep application 

programs and files in RAM. T he second way- for maximum battery 
conservation-allows you to use your RAM disk as the startup disk. 

To set up a RAM disk, you need at least 6 MB of RAM in your computer. 

If you have less than 8 MB of memory 

lf you have less than 8 MB of memory, set up a RAM disk that contains the 
applications and fi les you use most. 

Create a folder called "RAM Disk Backup." 

2 Put into the RAM Disk Backup folder your favorite application(s) and files you frequently 
use. 

Try to keep additions to this folder to a minimum. 

3 Select the RAM Disk Backup folder. Then choose Get Info from the File menu in the 
Finder, find the size of your RAM Disk Backup folder, and close the Get Info window. 

You' ll need to remember the size of your RAM Disk Backup folder. Write it 
down if you need to. 

4 Choose Control Panels from the Apple (ti) menu and open the Memory control panel. 

Memor-y 



The Memory control panel appears. 

ID 

@) 
Virlu•l~f'OOr\I 

Oen 
@01r 

Cl) 
RAM Oisk 

@On 
Oo1r 

Memor 

Stlitct HMd Ou:lc: 

l= M111:1111osllllll ==:J 
A•oil.ablt on disk : 3M 

Ani~lt bui1t·in mtmOf'\I : 4M 

Ptrunt of 1v1i11blt mtmor\j 
to un for' I RAM disk: :_--= -m ----=-- i 

0"5 :!()jg 

RAMOtskSlu 

( Use Defaults J 

5 Click the On button under RAM Disk. 

6 Drag the slider to set the percentage of memory to use for the RAM disk. 

Adjust the size to fit the contents of your RAM Disk Backup folder. Make 
sure you allocate enough RAM to fit the size of your folder, or you will have 
to repeat this step. 

7 Close the Memory control panel and restart your PowerBook. 

A RAM Disk icon appears on your desktop. 

8 Copy the contents of your RAM Disk Backup folder to your RAM disk. 

9 See "Using the RAM Disk" later in this section. 

IMPORTANT When you need to turn off the computer, make sure you choose 
Shut Down from the Special menu. If you use the power switch to turn off 
your computer, you will lose the contents of the RAM disk. 
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If you have at least 8 MB of memory 

If your PowerBook has 8 MB of memory or more, you can set up a RAM disk 
that contains the files needed to start up your PowerBook. This provides 
maximum battery conservation. 

1 Select the System Folder on your hard disk and choose Duplicate from the File menu 

This creates a folder called System Folder copy. 

Remove any extra extensions, fonts, and control panels you don't use. 

Make sure not to delete the files called Finder and System from the System 
Folder copy, or the file called Assistant Toolbox from the Extensions folder in 
the System Folder. 

3 Create a folder called "RAM Disk Backup." 

4 Put the System Folder copy, your favorite application program or programs, and files 
you frequently use into the RAM Disk Backup folder. 

Try to keep additions to this folder to a minimum. 

5 Select the RAM Disk Backup folder. Then choose Get Info from the File menu in the 
Finder, find the size of your RAM Disk Backup folder, and close the Get Info window. 

6 Choose Control Panels from the Apple (S) menu and open the Memory control panel. 

Memot'"y 



The Memory control panel appears. 

Disk Coleht 
Alw.iys: On 

Memor 

Stltot H• rd Disk : 
···-···-···-···-······-·····-·-.. ·---·-····--···-······-···-···-··1 lr.:-:.i Mni:in11>sh 110 .... 

Oen 
@Off 

rqT") RN1 Disk 

~ @en 
Oott 

Avai1ablt on disk : 3M 

Ptrctnt of availablt mtmor1,1 
to U.st '°' • RAM disk : 

0115 50115 

RAM Disk Sitt 

100% 

l2040K I 

[ Use oeroults J 

7 Click the On button under RAM Disk. 

8 Drag the slider to set the percentage of memory to use for the RAM disk. 

Adjust the size to fit the contents of your RAM Disk Backup folder. Make 
sure you allocate enough RAM to fit the size of your folder, or you will have 
to repeat this step. 

9 Close the Memory control panel and restart your computer. 

A RAM Disk icon appears on your desktop. 

~O Copy the contents of your RAM Disk Backup folder to your RAM disk. 

~ 1 Choose Control Panels from the Apple (ti) menu and open the Startup Disk control 
panel. 

~2 Select your RAM disk in the Startup Disk window and close the Startup Disk control 
panel. 

13 Choose Restart from the Special menu. 

14 See "Using the RAM Disk" (the following section). 

IMPORTANT When you need to turn off the computer, make sure you choose 
Shut Down from the Special menu. If you use the power switch to turn off 
your computer, you will lose the contents of the RAM disk. 
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Using the RAM Disk 

1 Start up the application programs and files on the RAM Disk while your PowerBook is 
plugged into the power adapter. 

Using the power adapter saves your battery. 

2 Put your PowerBook to sleep. 

3 Unplug the power adapter. 

Your documents will be loaded into RAM when your PowerBook comes out 
of Sleep. 

4 While you are running your PowerBook off the battery, try to avoid using any files that 
are not on the RAM Disk. 

5 When you save new files, save them to the RAM Disk. 



Improving pointer display 

You may notice that the pointer sometimes disappears from your PowerBook's 
screen when you move the pointer quickly. You can set your trackpad (or 
external mouse) to have "tracks" so you can always see the pointe r on the 

screen. You do this in the Mouse control pane l. 

Choose Control Panels from the Apple (ti) menu and open the Mouse control panel. 

Mouse 

The following control panel appears: 

(2) ~ ~ 
0 00000® 

Ytry S1ov Sto'tt f' H t 

+ + + 
• o • @ • o 

Ooubl<·Cllek Sp<td 

Moust Tricks 

~ I~ I\~ 
0 0 ® 00 
Off Short l ""'l 

~Thick l·b<>m I 

The settings in this section control the tracking 
speed of an external mouse. Change the tracking 
speed of the trackpad in the Trackpad control panel. 

You can set the double-click speed here. 

You can set the pointer tracks here. 

2 Click the mouse tracks length you want. 

3 To display a thicker I-beam on your PowerBook, click the checkbox labeled Thick I-beam. 

This makes the I-beam more visible on display screens. 

4 Close the Mouse control panel. 
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Printing later 

If you use a PostScript laser pri nter (such as a Laserwriter Pro 600) on a 
network, you can set up documents to print the next time you connect to the 

network printer. 

1 Choose Print in the application program you are using. 

Click Print in the dialog box. 

The fol lowi ng dialog box appears: 

This document con not be pr inted ot this 
t ime on the pr inter "LoserWrlter · becouse the 
pr inter Is not ouolloble on the RppleTolk net work. 

( Oon·t Print J t Print Loter J 

2 Click Print Later. 

The next time you conn ect to an AppleTalk network printer, this document is 
printed . 



Traveling with the PowerBook 
The safety instructions in the first part of this book also apply when you are 
traveling. In addition, note these precautions: 

• Do not transport your PowerBook while it is turned on. Put your computer 
to sleep or sh ut it down before you move it. 

• Transport batteries either inside the computer o r with the protective slider 
covering the battery contacts. Do no t transport unprotected batteries. 

• Do not check your computer as baggage. Carry it with you. 

• Have security officia ls man ually inspect your computer a nd disks if you do 
not want to pass them through X-ray machi nes. 

• Take the system software disks that came with your computer with you in 
case you need to reinstall system software. 

• Be prepared to show security officials that your computer is working. Have 
a charged battery or a power adapter ready to use. 

• Some airlines may restrict or prohibit the use of computers in flight. Check 
ahead to find out what restrictions, if any, apply. 

• Take the necessary plug adapters if you're traveling overseas. (You may 
need to use them with the power adapter.) You do not need a voltage 
transformer. The power adapter can handle 90 volts to 260 volts AC 

(48 Hz to 62 Hz). 

Check the diagrams below to determi ne which plug adapters you' ll need, or 

ask your travel agent. 

Outlet Type Locations 

United States, Canada, parts of Latin America, Japan, Korea, 
the Philippines, Taiwan 

Former Soviet Union, most of Europe, parts of Latin America, 
the Middle East, parts of Africa, Hong Kong, India, most of South Asia 

Mexico, United Kingdom, Ireland, Malaysia, Singapore, 
parts of Africa 

China, Australia, New Zealand 
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Storing the PowerBook 

Save your work on a hard disk or floppy disks. 

2 Choose Shut Down from the Special menu. 

3 Close the display. 

4 Recharge the battery or batteries. 

Be sure your batteries are fully charged if you are tak ing the computer places 

where you cannot plug it in. 

5 Store the computer in a cool, dry place. 

Storage temperatures should re main between 10°C and 40°C (between 50°F 
and 104°F). Avoid leaving the computer where temperatures may be extre me 

or unpredictable- in the trunk of a car, for example . 

Service and support 
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If your computer is malfunctioning but does not appear to be physically 

damaged, shut it down (and leave the power adapter plugged in, if possible) 
until you can get help. 

If you know or suspect that your computer is physically damaged, d isconnect 
the power adapter, remove the battery, and do not use the computer until it 
can be repaired. 

See the service and support information that came with your computer fo r 
infor mation about customer assistance. 



Using SCSI Devices 
•••••• 

Refer to this chapter for information 

about connecting SCSI devices 

and using your PowerBook 

as a SCSI disk. 

A SCSI device is any product-including hard disk drives, CD-ROM drives, 
scanners, and printers-that communicates with your computer by means of 
a standard electronic interface. (SCSI stands for Small Computer System 
Interface.) You can attach up to 6 SCSI devices to your computer by li nking 
them together in a chain that starts at your computer's SCSI port. 

The SCSI port on PowerBook computers looks like this: 

~ -SCSI port icon 

To connect a SCSI device to the SCSI port on your PowerBook, you need an 
Apple HDI-30 SCSI System Cable or equivalent. 
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Connecting SCSI devices to your PowerBook involves these steps: 

• installing software 

• setting SCSI ID numbers 

• checking that the SCSI chain is properly terminated 

• connecting cables 

These steps are described in the following sections. 

Installing software 
Most SCSI devices come with software that allows your computer to 
communicate with them. These programs are called drivers. (If no drivers 
come with a device, then it doesn't need any.) To install a driver, follow the 

instructions that came with the device. 

Setting SCSI ID numbers 
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Each device in a SCSI cha in must have a unique ID number between I and 6 
so the computer can identify it properly. 

WARNING Usi ng two or more devices with the same SCSI ID number 
can cause your equipment to malfunction. You could lose information 

as a result. 

Your computer has the SCSI ID number 7, and its internal hard disk has the 
number 0. 

See the documentation that came with your SCSI devices for information 
about ID numbers and how to change them. 



The ID numbers of Apple SCSI devices can be set as follows. 

Make sure the SCSI device is turned off. 

If the device is already part of a SCSI chain, make sure that all devices in the 
chain are turned off, including the computer. 

2 Locate the ID number indicator and switch (usually on the back panel of the SCSI 
device). 

3 Check the ID numbers of all the devices you want to connect. 

If a ll the devices have unique ID numbers, you can continue with the next 
section, "Checking That the SCSI Chain Is Properly Terminated." 

4 If you need to change a device's ID number, choose an available number between 
1and6. 

5 Insert the end of a straightened paper clip into the small hole below the ID number. 

6 Push repeatedly until the number you want appears. 
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Checking that the SCSI chain is properly terminated 
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To ensure accurate transmission of information, a chain of SCSI devices must 

have a terminator at each end. Terminators are built into some SCSI devices 
and can also be added externally. 

SCSI terminator 

• Your PowerBook's internal hard disk, which is the first device in the chai n, 
has a built-in terminator. However, you should also add external 
terminators as described in these instructions. 

• Externa l SCSI devices from Apple do not have built-in termi nators. 

• External SCSI devices from other vendors may have built-in terminators; 
see the documentation that came with the device. 

If you are attaching one SCSI device 

Make sure that there is 

• an external terminator between the system cable and the SCSI device and 

• a terminator (internal or external) on the SCSI device. 

If you are attaching more than one SCSI device 

Make sure that there is 

• a terminator (internal or external) on the last SCSI device; and 

• no other terminators (internal or external) or other external devices in the 
chain. 

If you have too many devices with inte rnal term inators, your Apple­
authorized service provider can remove extra terminators. 

Chain configurations are shown in the illustration in step 6 of the followi ng 
section. 



Connecting cables 

WARNING When making SCSI connections, always turn off power to all 

devices in the chain, including your computer. If you don't you could 
lose information and damage your equipment. 

1 Shut down your PowerBook and all SCSI devices in the chain. 

2 Connect an Apple HDl-30 SCSI System Cable to your computer. 

Attach the smaller end of the cable to your computer's SCSI port (marked 
with the icon ~). 

3 If necessary, connect a terminator to the system cable. 

If you are attaching only one SCSI device, see the section "If You Are 
Attaching One SCSI Device" in "Checking That the SCSI Chain Is Properly 
Terminated." 

If you are attaching more than one SCSI device, see "If You Are Attachi ng 
More Than One SCSI Device" in "Checking That the SCSI Chain Is Properly 
Terminated." 

4 Connect the terminator or system cable to either port on the SCSI device. 

5 To connect the next device, use a SCSI peripheral interface cable. 

Both ends are the same. Attach one connector to the available SCSI port on 
the fi rst device, and the other connector to either SCSI port on the next 
device. 
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6 Unless the last device has an internal terminator, connect a terminator to its remaining 

port. 

The illustration shows where to add cable terminators. 

Connecting one SCSI device 

Terminator 

~~~~ 
°""11 this SCSI device has an internal 

HDl-30 cable terminator, omit this external terminator. 

Connecting more than one SCSI device 

If this SCSI device has an internal 
terminator, omit this external terminator. 

I \ 

HDl-30 cable SCSI peripheral interface cables 

IMPORTANT The total length of a SCSI chain should not exceed 20 feet 
(6 meters). Apple SCSI cables are designed to meet this restriction. If you are 
using SCSI cables from another vendor, check the length of the chain. 

WARNING Once your SCSI devices are connected, always turn them on 
before turning on your PowerBook. If you turn the computer on fi rst, it 
may not be able to start up, or it may not recognize the SCSI devices. 



Using your PowerBook as a SCSI disk 

You can purchase a cable called the Apple HDI-30 SCSI Disk Adapter which 
lets you connect your PowerBook to another computer as a hard d isk. The 
PowerBook appears on the desktop of the other computer as a hard disk icon, 
and you can transfer information between the computers by dragging files. 
This feature is called SCSI disk mode. 

WARNING Follow the steps for connecting and disconnecting SCSI 
devices carefully to avoid loss of information and damage to your 
equipment. 

Connecting your computer as a SCSI disk 

Before making any connections, you need to assign a unique SCSI ID number 
to the PowerBook. 

1 Choose Control Panels from the Apple (ti) menu of your PowerBook computer. 

2 Open the PowerBook Setup control panel. 

[I] 
Po\o/erBook Se~up 

3 In the SCSI Disk Mode ID section of the control panel, click the ID number you want to 
assign. 

If you are connecting the PowerBook to an existing SCSI chain, make sure to 
give it an ID number different from those of the other devices. 

I ~ SCS I Disk Mode 

D: 01 ® 2 Q3 O• Q5 06 

4 Close the PowerBook Setup control panel. 

5 Turn off the PowerBook by choosing Shut Down from the Special menu. 
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6 Shut down the computer you are connecting to, and turn off other devices in the SCSI 

chain. 

7 Connect the PowerBook to the other computer or, if there are already devices attached, 
to the end of the SCSI chain. 

Remove the term inator from the last device in an ex isting chain before 
connecti ng the Power Book. 

WARNING Always shut down the PowerBook before connecting or 
disconnecti ng the SCSI disk adapter cable. Connecting the adapter cable 
while the computer is turned on can damage the computer. 

8 Turn on the PowerBook by pressing the power button. 

After a few seconds a SCSI icon appears on the screen, showing the ID 
number you assigned in step 3. 

WARNING If you do not see the SCSI icon, and the computer e ither 
starts normally or displays an error message, choose Shut Down (if you 
can) and then immediately disconnect your computer from the SCSI 
chain. If you can't choose Shut Down, try pressing the power button. 
If you cannot shut down your PowerBook, you should disconnect the 
cable anyway, or you may lose information. Then go back and repeat 
steps 6 through 8. 

9 Turn on the other SCSI devices in the chain, if any. 

10 Turn on the other computer. 

The PowerBook appears as a hard disk icon on the screen of the computer 
you connected it to. You can now transfer and use fi les as if the PowerBook 
were an external disk drive. 



Simplifying the SCSI disk connection process 

If you regularly plan to use your PowerBook as a SCSI disk with the same 
computer, you can leave the SCSI disk adapter cable attached to the other 
computer or its SCSI chain. When you want to use your PowerBook as a 
SCSI disk, simply shut down all devices and connect the adapter cable to the 
SCSI port on your PowerBook. 

These cables can stay attached to your 
des~op MaII chain. 

\ 
HDl-30 SCSI disk adapter Connect and disconnect your computer here. 

WARNING Always disconnect your PowerBook from the adapter cable 
when you are not using it as a SCSI disk. Your PowerBook will not 
work correctly if the adapter cable remains attached. 

Drawing battery power in SCSI disk mode 

Your PowerBook continues to draw battery power when you use it as a SCSI 
disk. Low battery power is indicated by a blinking low-power warning on the 
PowerBook's screen. 

If you see this warning whi le usi ng your computer as a SCSI disk, either plug 
in the power adapter or quit SCSI disk mode, as described in the next section, 
so you can remove the battery for recharging. 
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Quitting SCSI disk mode 
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1 Shut down the computer your PowerBook is connected to. 

2 Tap the Power On {<I} key once to turn the PowerBook off. 

3 Turn off any other SCSI devices in the chain. 

4 Disconnect the PowerBook from the adapter cable. 

If you regularly plan to connect your PowerBook to the same computer, you 
can leave the adapter cable attached to the SCSI chain or the other computer. 
See "Simplifying the SCSI Disk Connection Process," in "Using Your 
PowerBook as a SCSI Disk," earlier in this chapter. 

IMPORTANT Do not leave the adapter cable attached to the PowerBook. If you 
do, the computer will behave as though it is sti ll in SCSI disk mode when you 
try to restart. 

5 If necessary, disconnect the adapter cable from the other computer or its SCSI chain. 

Your equipment is now ready for normal use. Make sure that the SCSI chain 
is properly termi nated . 



Using an External Monitor 
• • • • • • 

Refer to this chapter if you want to 

use an external monitor in addition 

to the built-in PowerBook display. 

Your PowerBook has a video port to which you can connect most Apple 
monitors. Contact your Apple-authorized dealer for information on which 
monitors are compatible with your PowerBook. 

To connect an external monitor, you need the PowerBook video adapter cable 

that comes with your computer. 

Your PowerBook a lso supports most VGA monitors. To connect a VGA 
monitor, you need an adapter cable, which should come from the same source 
as the monitor. 

An external monitor connected to your computer can function as an extension 

of your PowerBook's built-in screen- that is, you can drag objects from one 
screen to another and do your work on either one. Or you can show the same 

image on both screens. 
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Connecting an external monitor 
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To connect a monitor, follow these steps. (If you are connecti ng a monitor 
from a manufacturer other than Apple, be sure to read its manual.) 

Choose Shut Down or Sleep from the Special menu. 

If you connect a monitor with your computer turned on, the computer wi ll 
not recognize the monitor. 

2 Plug in the power adapter that came with your PowerBook. 

You must use the power adapter whenever you are using an external monitor. 

3 Place the monitor where you will be using it. 

Keep the computer and the monitor at least 8 inches apart to avoid 
interference between the monitor and your computer's floppy disk drive, 
wh ich can cause errors on your floppy disks. 

D O DD Floppy drive 

.......... ~/ 
L g j I I 

8 inches minimum 

Arrange the monitor so the top of the screen is slightly below eye level while 
you work. Position the monitor to minimize glare and reflections on the 
screen from lights and windows. 

4 Make sure the monitor's power cord is attached to the monitor, then plug the other end 
into a grounded outlet or power strip. 

If your monitor's power cord is designed to plug into the power receptacle on 
the back of a computer, rather than into an electrical outlet, you can obtain a 
cable with the correct plug from your Apple-authorized dealer. 

If you are using a power strip, make sure it is turned on. 



5 Attach one end of the video cable to the monitor and tighten the thumbscrews. 

(Some monitors have an attached video cable.) 

6 Attach the other end of the video cable to the PowerBook's video adapter. 

7 Attach the other end of the video adapter to the video port (IOI) on the computer's back 
panel. 

~--Video port icon 

r J- Video port 

8 Turn on the external monitor. 

9 Press the Power On key to turn on or wake your computer. 
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Trouble? 
• Nothing happened when you tried to turn on the PowerBook. 

Make sure that all your equipment is connected properly, and try pressi ng 

the Power On key again. 

Make sure that the power adapter is plugged into both the computer and an 
electrical outlet. If you are using a power strip, make sure it is turned on. 

• The computer is on, but the external monitor is dark. 

Make sure that the monitor's power cord is connected, and that its power 

switch is on. Try adjusting the monitor's brightness and contrast sett ings. If 
this doesn't work, try restarting your computer. 

Activating the external monitor 
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You must activate the external monitor each time you connect it to your 
computer in order to use it. 

Choose Control Panels from the Apple (ti) menu, and open the Monitors control panel. 

You' ll see two rectangles representi ng your two monitors. 

2 Click the rectangle 1 (representing your external monitor). 



Displaying the menu bar on the external monitor 
To display the menu bar on the external monitor, follow these steps. 

1 Choose Control Panels from the Apple (9) menu, and open the Monitors control panel. 

You' II see two rectangles representing your two monjtors. 

2 Drag the menu bar from rectangle 2 {representing your PowerBook screen) to rectangle 1 
{representing your external monitor). 

3 Close the Monitors control panel. 

The menu bar appears on your external monitor. 

Trouble? 
• The computer is on, and the external monitor looks like it's on, but the screen is 

blank. 

You must activate the external monitor each time you connect it to your 
computer. See 'J\ctivating the External Monitor." 
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Working with an external monitor 
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This section summarizes how your computer and external monitor behave 

when you use them together. 

Sleep 

The PowerBook wi ll not sleep when a n external monitor is con nected. If you 
are using an external monitor, it's a good idea to leave processor cycling 

turned on. (You change processor cycli ng options in the PowerBook control 

panel. See Chapter 6 for help.) 

Backlight dimming 

The dimming feature in the PowerBook control panel turns the screen 
brightness down to a low level when you haven't used the computer for a few 
minutes. (You can think of dimming as "screen sleep.") 

Dimming also affects the external monitor. When you move your finger on 

the trackpad or press a key on the keyboard, the brightness is restored on both 
screens. See Chapter 6 for more information on backlight dimming. 



Using a monitor for presentations 

Once you have attached an external monitor to your PowerBook, you can use 
that monitor to show whatever is displayed on your built-in display. This 

"video mirroring" capability is usefu l when you' re making a presentation to a 
group. You tu rn video mi rroring on or off in two places: 

• the Video Mirroring module in the Control Strip (See Chapter 5 for 
instructions on using the Control Strip.) 

• the PowerBook Display control panel 

To use the PowerBook Display control panel: 

1 Choose Control Panels from the Apple (ti) menu and open the PowerBook Display 
control panel. 

PowerBook Display 

2 Click the On button under Video Mirroring. 

:'.O PowerBook Display 

Video Mirroring 

l;;b @on 

U Ooff 

3 To turn off video mirroring later, click Off. 
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Disconnecting an external monitor 
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1 Make sure your computer is shut down or in sleep. 

If you disconnect the monitor while your computer is on, the computer will 

turn itself off, and you will lose any information you d id not save. 

2 Disconnect the video adapter from the video port on the computer's back panel. The 
video port is marked with this icon: IOI 

Press the small buttons on both sides of the connector to remove the video 

adapter from the port. 



Connecting Other Devices 
• • • • • • 

Refer to this chapter when you want 

to expand your PowerBook system 

with additional devices or memory. 

The back panel of your computer has several ports for connecting other 

devices : 

= Power adapter port 

~ SCSI port (HDl-30) 

IOI Video port 

<-··> Ethernet port 

~ Apple Desktop Bus (ADB) port 

t Sound input port ~>)) Sound output port 
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Connecting a modem 
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If your computer has an internal mode m, see the documentation that came 

with your modem for more information. 

You can also connect an external modem to the serial port on the back panel 

of the computer. 

To connect an external modem, follow these steps. 

Make sure the computer is in sleep or shut down. 

2 Connect the modem to a power source and to the phone line. 

See the documentation that came with the modem. 

3 Make sure the modem is turned ott. 

4 Connect the modem cable to the serial port marked with this icon: 

5 Turn on the modem. 

6 Wake or restart the computer. 

7 Choose Control Panels from the Apple (ti) menu and open the PowerBook Setup control 
panel. 

~ 
Po\•terBook Setup 

8 Click the Normal button. 

~o PowerBook Setup 

Modem 

0 Compatible @Normal 



9 Close the control panel. 

The external modem is ready to use. If you have problems connecting to the 

external modem after following these steps, repeat steps I through 7 and then 
choose Compatible instead of Normal in the PowerBook Setup control panel. 

If you have both an internal and an external modem, reme mber to select the 
modem you want to use in the PowerBook Setup control panel before 

opening your telecommunications program. 

Connecting a printer 

The serial port on your computer can accept either a direct connection (to a 
prin ter such as the Style Writer) or a network connection (to a printer such as 
a LaserWriter). The serial port is marked with this icon: 

Some printers, including the Personal LaserWri ter SC, are connected through 
the SCSI port (marked with the icon <3-). You can also connect your 
PowerBook to a printer with an Ethernet port. See "Connecting Directly to 
Your Printer With Ethernet" in Chapter 11 for instructions. 

Follow the instructions that came with your prin ter to connect it to your 
computer. 
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Connecting a mouse or other ADB device 

Your compute r has one Apple Desktop Bus (ADB) port, to which you can 

connect low-power input devices (such as a mouse). The ADB port has this 

icon: ::t>. Connect ADB devices only when your PowerBook is off or in sleep. 

Make sure that any such devices you connect are designed for po rtable 

computers. Standard ADB devices may drain your batte ry very quickly, even 

if the power adapter is plugged in. Low-power devices are marked with this 
icon: o . You can attach up to th ree devices in a chain to the ADB port. See 
the instructions that came with your A DB device or devices for information 

about their power consumptio n, and make sure that the total power drawn by 

all devices you' re connecting does not exceed 200 mA. 

Using sound input and output devices 
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Sound input devices 

Your computer has a built-in microphone centered just below the display. The 

microphone is controlled by the program you use to record sounds. (Sound 

recording is described in the chapter on sound in the Macintosh Reference 
book.) 



In addition to it s internal microphone, your PowerBook has a stereo sound 
input port (marked with this icon: ~) to which you can connect an external 
sound input device that provides line-level output. 

You cannot use both the internal microphone and an external sound input 

device at the same time. You can select a sound device in the Sound control 
panel (see the Macintosh Reference book). 

WARNING Do not plug a sound output device (such as a pair of 
headphones) into the sound input port. Doing so may damage your 

audio equipment. 

Sound output devices 

The PowerBook also has a stereo sound output port (marked with the icon ~ »)) 

to which you can connect speakers, an amplifier, headphones, or other audio 
output devices. The sound output port accepts a standard stereo miniplug, 
like that used to attach headphones to a portable tape player. 
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Adding memory to your computer 
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Your PowerBook computer comes with at least 4 MB of RAM. By addi ng 
memory upgrade cards you can increase your computer's memory. You can 
find out how much memory your computer has by choosing About This 
Macintosh from the Apple ( ti) menu in the Finder. 

You can purchase memory upgrades from Apple-authorized dealers. 

WARNING To avoid damage to your PowerBook, Apple recommends that 
only an Apple-certified technician install additional RAM. Consul t the 
service and support information that came with your computer for 
instructions on how to contact an Apple-authorized service provider or 
Apple for service. If you attempt to install additional RAM yourself, any 
damage you may cause to your equipment will not be covered by the 
limited warranty on your computer. See an Apple-authorized dealer or 
service provider for additional information about this or any other 
warranty question. 

Your PowerBook computer also supports virtual memory, a feature that 
makes use of hard disk space to provide additional RAM. See the Macintosh 
Reference book for more information. 



Read this chapter when you 

want to take advantage of 

your PowerBook's built-in 

Ethernet capability. 

Using Your PowerBook With Ethernet 
• • • • • • 

Connecting your PowerBook to Ethernet 
Ethernet network Your PowerBook comes with a built-in Apple Ethernet port. 

You can connect to high-speed Ethernet networks to access a variety of 
networking services. To connect your PowerBook to an Ethernet network, 

you need an Ethernet adapter and cable. Several Ethernet adapters are shown 
below. See your Apple-authorized dealer or network admi nistrator for more 

information on Apple Ethernet adapters for your PowerBook. 

Apple Ethernet 
thin coax transceiver 

Apple Ethernet 
AUi adapter 

Apple Ethernet 
twisted-pair transceiver 
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IMPORTANT You can connect your PowerBook to any standard Ethernet 
network. The built-in Ethernet supports EtherTalk Phase 2 (AppleTalk 
Phase 2 protocols fo r Ethernet networks). The built-in Ethernet does not 
support EtherTalk Phase 1 (AppleTalk Phase 1 protocols for Ethernet 
networks). You can also purchase products that allow you to communicate 
over Ethernet using other protocols, such as MacTCP. 

There are two ways to connect your PowerBook to an Ethernet network: 

• Connect the PowerBook between other devices in a network. 

• Connect the PowerBook to the end of an existing network. 

Connecting your PowerBook between two devices on an Ethernet network 

112 Chapter 11 

When you connect the PowerBook between two devices on a network, you 
may need to briefly interrupt communication between network users on both 
sides of the connection. Be sure to notify users before add ing the PowerBook 
to the network. 

D D 

1 Plug the cable on your Apple Ethernet adapter into the Ethernet port on the PowerBook. 

The Ethernet port has this icon: <···> 



2 Disconnect one Ethernet cable from the network device immediately to the left or right 
side of the PowerBook. 

3 Plug an Ethernet cable into the socket you have just freed and into the PowerBook's 
Ethernet adapter. 

4 Plug the Ethernet cable you disconnected in step 2 into the remaining socket of the 
PowerBook's adapter. 

5 Turn on EtherTalk in the Network control panel. 

See the Macintosh Reference book for help using the Network control panel. 

Connecting your PowerBook to the end of an Ethernet network 
Connecting the PowerBook to the end of a network will not interrupt 
communication among network users. 

1 Plug the cable on your Apple Ethernet adapter into the Ethernet port on the PowerBook. 

2 Use an Ethernet cable to connect the adapter to the network as shown. 

D 

3 Turn on EtherTalk in the Network control panel. 

Using Your PowerBook With Ethernet 
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Connecting directly to your printer with Ethernet 

You can connect your PowerBook to any printer with an Ethernet port. 

1 Plug the cable on your Apple Ethernet adapter into the Ethernet port on the PowerBook. 

2 Plug an Ethernet adapter into the Ethernet port on your printer. 

3 Connect the two adapters with an Ethernet cable, as shown. 
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Tips and Troubleshooting 
• • • • • • 

Refer to this chapter for solutions 

to some common problems. 

This chapter describes possible causes and solutions for some common 
problems you may have with your PowerBook or associated equipment 
provided by Apple. Try the possible solutions in the order they are listed until 
the problem is solved. Check the specific sections in thi s book and in the 
Macintosh Reference book for additional help. 

WARNING If you have a problem with your PowerBook and nothing 
presented in this chapter or in the manuals that came with your 
computer solves it, consult the service and support information that 
came with your computer for instructions on how to contact an 
Apple-authorized service provider or Apple for assistance. If you 
attempt to repair the computer yourself, any damage you may cause to 
the computer will not be covered by the limited warranty on your 
computer. Contact an Apple-authorized dealer or service provider for 
additional information about this or any other warranty question. 
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The PowerBook 
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The computer won't start. 

• The computer may be on, but the screen brightness or contrast may be 
turned down. Adjust the brightness and contrast controls. 

• The battery or batteries may be drained. Plug in the power adapter, wait 15 
minutes, and then try to turn on the computer. 

• The re may be a temporary problem w ith the computer's power syste m. 

Hold down the Control , Option, 3€ (Command), and Power On ( <J) keys 
at the same time, and then try to turn the computer on again. 

The computer just stopped. 

• The computer may have gone to sleep. (If a green light flashes at the top 
of the display, the computer is in sleep.) Press any key on the keyboard to 

wake the computer. 

• The battery may have drained so far that the computer has put itself to 
sleep to protect the contents of RAM. Plug in the power adapter, wait 15 
minutes, and then turn the computer on again. 

• The computer may have "crashed" due to temporary software problems. 
Hold down the Control, 3€ (Command), and Power On ( <J) keys at the same 
time a nd then try to turn the computer on again. You will lose any work 
you have not saved. 

The computer won't restart. 

Try to restart your computer using one of the following methods. Try them in 
the o rder g iven. 

• Press the Control, 3€ (Command), a nd Power On (<J) keys at the same time. 

Restarti ng the computer this way does not affect your RAM disk (if you 
created one) or its contents. 

• Hold down the Control, Option, 3€ (Command), and Power On ( <J) keys at 
the same time. 

Restarting the compute r this way erases the contents of a RAM disk. 



• If you still can't restart, try restarting from a floppy disk. 

I. Insert the Disk Tools disk into the floppy disk drive. 

2. Press the Power On (<I) key. 

If the computer restarts from a floppy disk, there is probably a problem 
with your hard disk. You may be able to fix the problem yourself (using the 
Disk First Aid program or another disk repair program; see the Macintosh 
Reference book for help). Or you may prefer to take the computer to your 
Apple-authorized service provider. 

The computer is very hot. 

• It is normal for the computer to be warm to the touch while you are using 
it, especially on the side beneath the keyboard. If the computer seems 
unusually hot, try the following: 

• plug in the power adapter 

• turn down the screen brightness (·:9:) 

• turn on backlight dimming 

• use the Better Conservation setting in the PowerBook control panel 

• make sure processor cycling is turned on in the PowerBook control 
panel 

• disconnect the external monitor 

• put the computer to sleep or shut it down 

See Chapter 6 for more information on reducing your computer's power 
consumption. 

The computer exhibits odd behavior, such as many unexplained system failures. 

• A common cause of unexplained problems is multiple System Folders on 
your computer's startup disk. The System Folder that the PowerBook is 
using to operate is marked with a special icon. 

[CJ 
Sy stem Folder 

Use the Find command in the File menu to locate any other System 
Folders, and drag them to the Trash. 
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Power 
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• You may have a virus on your hard disk. Use a virus-detection program to 

check all your disks, and eliminate any viruses the program finds. 

• You may be using a program that's not compatible with your computer's 

system software. Check the information that came with the program or 

contact the manufacturer. 

• You may have added a control panel or system extension that is 

incompatible wi th other programs you use. Restart the computer with the 

Shift key held down until you see the message "Extensions off" in the 
Welcome tu Macin tosh screen. If the problem <loes not recur, remove any 

such items you recently installed. 

• You may need to reinstall system software. See Appendi x A for 

instructions on installing system software. 

The battery is draining too fast. 

• Look at the battery consumption rate in the Battery Monitor module of the 

Control Strip. If the gauge is to the right, then your computer is consuming 

battery power at a rapid rate. 

• Turn down the screen brightness, turn off virtual memory, use the Better 

Conservation setting in the PowerBook control panel, or work with the 

power adapter plugged in . 

• You may be using an input device (such as a mouse intended for desktop 
Macintosh systems) not designed for PowerBooks. Make sure to use only 

low-power input devices (marked with the icon O ). 

• Your computer supplies power to d1e modem whenever a communications 

program is open. Quit your communications program if you aren't using it. 

• If you aren't using network services, you can also save power by turning off 

AppleTalk in the C hooser or in Lhe AppleTalk Switch modul e of d1e 
Control Strip. 

• Your battery may need to be discharged and recharged completely. 

• Older PowerBook batteries do not hold a charge as well as new ones. You 
may need to replace the battery. 



The screen 

The battery can't be recharged. 

• The re may be a loose connection. Take the battery out and put it back in 

the computer, and make sure the power adapter is properly plugged in. 

• If all connectio ns are O K, then the battery is probably da maged or dead. 

Obtain a replacement battery from your Apple-authorized dealer. 

The computer goes to sleep too often. 

• Ope n the Powe rBook control panel a nd move the battery conservation 

slider toward Be tter Performa nce or choose Better Performance in the 

Power Settings module of the Control Strip. 

The computer doesn't go to sleep automatically. 

• You may have selected " neve r" on the Syste m Sleep slider i n the C ustom 

section of the PowerBook control pane l. Drag the slider to a lower setting. 

• You may be connected to a shared disk o n the network. 

• The serial port may be in use by a telecommunications program or a 

printe r. 

• One or more applications may be doing work in the background. You can 

choose Sleep from the Specia l menu to override th em. 

• The compute r does not go to sleep if AppleTalk is active and the power 

supply is plugged in. Turn AppleTa lk off in the AppleTalk Switch module 

in the Control Strip. 

See C hapte r 6 for more information about batteries and power consumption. 

The screen is too dark. 

• Whe n you first turn on your compute r, it may take several minutes for the 

screen brightness to "warm up," especially if you've chosen a high setting. 

• The screen brightness or contrast may not be optima l for the surrounding 

lighting. Adj ust the brig htness(·:<?:·) o r contrast (ct) setting. 
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• The screen dims automatically when the batteries start to run low. You may 
need to recharge or replace the batteries before you can turn up the 
brightness. 

• Screen dimming may be on. Press any key or touch the trackpad to restore 
the screen's brightness. 

The screen is flickering. 

• This problem sometimes occurs when your screen is set to display the 
maximum number of colors or grays. Try adjusting the contrast control, or 
select fewer colors or grays in the Monitors control panel. 

The pointer moves too fast or too slowly. 

• You need to adjust the pointer's tracking speed. Open the Trackpad control 
panel (or Mouse control panel if you have a mouse connected to your 
PowerBook) and choose a more comfortable setting. 

The pointer won't move at all. 

• A software problem may have caused the computer to "freeze." Hold down 
the Control, X (Command), and Power On ( <]) keys at the same time. You 
will lose any work you have not saved. 

A window has disappeared. 

• Another open window on the desktop may have covered the window you're 
looking for. Move, resize, close, or hide windows you aren't using until you 
see the one you want. 

• Windows belonging to open but inactive programs may be hidden. Choose 
Show All from the Application menu (in the upper right-hand corner of 
the desktop) to show hidden windows. 

An icon is blinking in the menu bar. 

• One of your programs needs your attention. For example, you may have set 
the Alarm Clock to go off at a particular time, or PrintMonitor may be 
alerting you to a printing problem. Make the program active and take the 
necessary action. 



Memory 

SCSI devices 

A "not enough memory" message appears when you try to open a program. 

• Quit any programs you aren't using, then try again to open the program you 
want. If that doesn't work, restart the computer. Sometimes restarti ng 
makes additional memory avai lable. 

• If you are using a RAM di sk or a disk cache, reduce its size a nd then 
restart the computer. 

• Use extra space on your hard disk as virtual memory to inc rease the 
amount of memory available for opening programs. (Use virtual memory 

only when the power adapter is plugged in.) You can turn on virtual 
memory in the Memory control panel. 

• If you consistently want to open more programs tha n memory allows, you 
can purchase a memory expansion card from your Apple-authorized dealer. 

You can't turn on the computer after connecting a SCSI device. 

• SCSI devices connected to your computer must be turned on before the 

computer itself. Turn on the SCSI device(s) first, and then turn on the 
computer. 

The computer doesn't recognize your SCSI devices. 

• When connecting SCSI eq uipment, it is important to use the right cables 
and the correct number and placement of cable terminators. Check the 
cables and terminators in the SCSI chain and make sure that a ll cables are 

firmly attached. 

• The devices may be off. Check to make sure that they are plugged in and 

turned on. 

• When the computer is in SCSI disk mode, tap the Power On (<l) key to 
turn the PowerBook off, and then try to turn the computer on again. 

• If the device is a disk drive, it may need to be initialized before you can use 
it. See the in structions that came with the device. 
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• The software (driver) needed to communicate with the device may not be 

installed in your System Folder. See the instructions that came with the 

device. 

• Two or more devices in the SCSI chain may have the same ID number. 
Check the TD number of each device to make sure each one has its own 

numbe r between I and 6, and change any numbers that are not uniq ue. 

See Chapter 8 for help using SCSI devices. 

External monitors 

The external monitor is dark. 

• Screen dimming may be on. Press any key or touch the trackpad button to 
restore the screen's brightness. 

• There may be no power to the monitor. Make sure that the monitor's power 
cord is connected, and that its power switch is on. 

• Try adjusting the monito r's brightness and contras t controls. 

The external monitor looks like it's on, but the screen is blank. 

• The computer's power adapter must be plugged in when you use an 
external monitor. With the computer in sleep or shut down, plug in the 
power adapter and the n wake o r start up the PowerBook. 

• C heck to make sure the video cable connection is secure. 

Disk drives and disks 
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The computer won't start up from the hard disk, or the hard disk icon doesn't appear on 
the desktop. 

• There may have been a temporary software problem. Shut down the 
computer, wait at least 10 seconds, and the n turn it on aga in. 

• There may be a problem with the system software on the hard disk. You 
can try two things: 



• Start up the computer with the Disk 1bols disk. If the hard disk's icon 
appears, reinstall system software as described in Appendix A. Disk 
repair programs can also sometimes fix problems with the hard disk. 

• Restart the computer, holding the Shift key down, until you see the 
message "Extensions off." If this solves the problem, drag any control 
panels or extensions you recently installed to the Trash. 

• The information on the disk drive may be damaged. Try using a disk repair 
program to repair or recover the information. If this doesn't work, you'll 
need to reinitialize the hard disk. See the Macintosh Reference book. 

• There may be a mechanical problem with the disk drive. If none of the 
above suggestions works, take the computer to an Apple-authorized service 
provider. 

The hard disk keeps stopping and starting again. 

• The hard disk may be going to sleep to conserve power. If this is 
interfering with your work, use the Better Performance setting in the 
PowerBook control panel. 

The hard disk is full. 

• You can reclaim space on your hard disk by removing unneeded files; 
installing a smaller, customized System Folder; turning off virtual 
memory; or using a disk optimization or file compression program. 

The icon of a floppy disk doesn't appear on the screen. 

• There may be a problem with the disk or disk drive. Try inserting a 
different disk. If its icon does appear, the original disk is probably damaged 
or may need to be initialized. You may be able to repair the disk or recover 
some of the information on it. See the the Macintosh Reference book. If the 
icon of the second disk does not appear either, the disk drive may be 
damaged. See an Apple-authorized service provider for repair. 

• Restart the computer, holding the Shift key down, until you see the 
message "Extensions off." If this solves the problem, drag any control 
panels or extensions you recently installed to the Trash. 
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A high-density (1.4 MB) disk you use with your PowerBook computer is not recognized 
by another computer. 

• Some disk drives cannot recognize high-density disks. Try inserting an 
SOOK or 400K disk in the disk drive of the other Macintosh. If that works, 
copy your files to an SOOK disk or a 400K disk. If you regularly plan to use 
floppy disk drives of different types, use the lower-capacity disks in all 
drives. 

You can't eject a disk from a floppy disk drive. 

• There may be a temporary mechanical problem with the disk drive. Restart 
the computer and hold down the trackpad button while the computer starts 
up. If that doesn't work, carefully insert the end of a straightened paper clip 
into the small hole near the disk drive's opening, and push gently until the 
disk is ejected. 

A message says that a disk is not initialized-but you know that it is. 

• The disk may not be seated properly in the disk drive. Eject it and try 
inserting it again. 

• The disk may be damaged. If you insert another disk in the drive and the 
message does not appear, the original disk probably needs repair. See the 
Macintosh Reference book. If the second disk is also not recognized, the disk 
drive may be damaged. See an Apple-authorized service provider for 
repair. 

• The disk may use a format that the Macintosh cannot recognize. You can 
use PC Exchange (see Appendix C) to translate some disks and file 
formats. 

• Restart the computer, holding the Shift key down, until you see the 
message "Extensions off." If this solves the problem, drag any control 
panels or extensions you recently installed to the Tra'ih. 

You can't delete a file on a floppy disk. 

• The disk may be locked. Unlock it by sliding the tab so that it covers the 
hole at the corner of the disk. 

• The file may be locked. You can unlock it in its Info window (choose Get 
Info from the File menu). Or you can hold down the Option key while you 
choose Empty Trash from the Special menu. 

• An application program may be using the file. Quit the program and try 
again. 



Modems 

Printers 

You can't save or copy files onto a floppy disk. 

• The disk may be locked. Unlock it by sliding the tab so that it covers the 
hole at the corner of the disk. 

• T he disk may be full. Delete files you no longer need or use a different 
disk. 

See the Macintosh Reference book for more information about working with 
disk drives and disks. 

The external modem doesn't work. 

• The modem may be turned off or improperly connected. Make sure it is 
turned on and that all connections are correct. 

• The modem port may not be activated. Open the PowerBook Se tup control 
panel and make sure that Normal is selected. 

The internal modem doesn't work . 

• The internal modem may not be activated. Open the PowerBook Setup 
control panel and make sure that Compatible is selected. 

See the modem manual and the instructions that came with your 
communications program for more informatio n about using and solving 
problems with your modem. 

Your computer can't find the printer. 

• The printer may be turned off Turn it on. 

• The printer may not be selected in the Chooser. Open the Chooser and 
select the printer you want to use. 

• Make sure that the printer is connected to the same port selected in the 
Chooser. 
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Your printer does not appear in the Chooser window. 

• The printer may not be connected properly. Check the connections 
between your computer and the printer, including relevant sections of the 
network if appropriate. 

• The printer software may not be in your System Folder. Install the software 
that came with your printer or system software update. 

• AppleTalk must be active before you can use a network printer. Make sure 
that AppleTalk is active in the Chooser. 

• If your network has zones, the printer you want may not be in the currently 
selected zone. Make sure the correct zone is selected. 

The network printer keeps restarting. 

• Someone on the network may be using a different version of the printer 
software. Everyone connected to a network should use the same printer 
software version. Consult the network administrator for more information. 

Nothing happens, or you see an error message, when you try to print. 

• The printer may not be turned on. Make sure it is turned on and warmed 
up. 

• The printer may be out of paper or have some other problem. Check the 
printer status lights and any messages on your screen. 

• Turn the printer off for at least 10 seconds. Then turn it on again, wait for it 
to warm up, and try to print again. 

• There may not be enough memory to print. Quit programs you aren't using 
and try again. 

Your documents are printed with the wrong fonts. 

• The printer may not have your fonts in its memory. You may be able to add 
the necessary fonts to your printer (see the Macintosh Reference book), or 
print on a different printer that has the fonts you want. If you have a 
LaserWriter, you can turn off Font Substitution in the Page Setup dialog 
box. 

See the Macintosh Reference book for general information about printing 
documents. See the printer manual for more information about your printer's 
features or problems with the printed output. 



Networks 

You can't find or can't open icons needed to set up file sharing. 

• One or more files may be in the wrong place. Make sure that the Sharing 
Setup file is in the Control Panels folder, and that the File Sharing 
Extension file, the Network Extension file, and the AppleShare file are in 
the Extensions folder. (Both folders are inside the System Folder.) 

• Some network software may not be installed properly. Use the Installer to 
install the appropriate network software. 

The shared disk you want to connect to does not appear in the Chooser window. 

• AppleTalk must be active before you can use a shared disk. Make sure that 
AppleTalk is active in the Chooser or in the AppleTalk Switch module of 
the Control Strip. 

• If your network hac;; zones, the shared disk you want may not be in the 
selected zone. Make sure the correct zone is selected. 

• The computer that the disk is on must be turned on before the disk can be 
shared. Make sure that computer is on. 

• The maximum number of users may be connected to the disk. Wait a few 
minutes and then try again. 

You can't open a shared disk or folder. 

• You may not have the access privileges needed to use the disk or folder. 
Ask the network administrator or the owner of the shared item to grant you 
access. 

• You may have entered your name or password incorrectly when you tried to 
open the shared disk or folder. Check with the owner of the item to make 
sure you are entering your name and password correctly, and try again. 

You can't connect to your own computer from another Macintosh. 

• Make sure that your computer is turned on, file sharing is turned on on 
your computer, you have the correct access privileges, and you entered 
your name and password correctly. 
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A program won't open. 

• Some programs can't be opened from a locked floppy disk. Make sure the 

disk is unlocked. 

• The program may be damaged. Recopy it from a known good source (such 
as the o rig inal program disk). 

• There may not be e nough memory available to open the program. Quit 
other programs or change the program's memory size in its Get Info 

w indow. 

Restart the computer, holding the Shift key down, until you see the 
message "Extensions off." If this solves the problem, drag any control 

panels or extensions you recently installed to the Trash. 

A program doesn't work, or malfunctions consistently. 

• You may have more tha n one copy of the program on your hard disk. 

Remove extra copies by dragging them to the Trash. 

• Your version of the program may not work with your system software. 
C heck with the software manufacturer to see which version of the program 
you should be using. 

• The program may be allocated less memory than it needs to work with 
your documents. C hoose Get Info from the Fi le menu and increase the 
me mory size. 

A message says that a program could not be found. 

• You may be trying to open a document created with a program you don't 
have o n your computer, or created with a different version of the program. 

Obtain the correct program and version. Or ope n the docume nt with 
another program that can read its format. (If a nother program can open a 
document, the program icon becomes highlighted when you drag the 
document icon to it.) 

You just did something you didn't mean to do. 

• You can usua lly undo your most recent action. Most programs have an 
Undo command in the Edit menu (:tt:-Z). You cannot undo more than one 

action. 

See the documentation that came wi th your programs for more information 
about their operation and features. 



Appendix A 
Installing System Software 

•• •••• 

Refer to this appendix 

when you need to install or 

reinstall the system software 

on your PowerBook. 

System software is the set of programs and other fi les that your comp.uter uses 

to start itse lf up, keep track of your fi les, and run the application programs 

you use. When you turn on your computer, it looks for a disk that contains the 

system software. System software is a lways in a fo lder call ed the System 

Folder. 

Any disk that contains a correct version of system software is a startup disk. 

The startup d isk is usua lly the hard disk that's inside your computer, though 
another hard disk or a floppy d isk can also be a startup disk. 

If your computer cannot find a startup disk, it displays this icon in the middle 

of the screen: 

If you see that icon, you may need to i nsta~ 1 or reinstall system software on 

your computer's internal hard d isk. You can also attach your computer to an 

external hard d isk that contain s the system software. 

If your hard disk already has system software on it and you see that icon: Your 

hard disk or system software may be damaged, or there may be problems with 
SCSI devices attached to your computer. (See C hapter 8 for more infor mation 

o n SCSI devices.) You may need to re install the system software. See the 
section on reinstall ing system software later in th is appendix for instructions. 
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Before you begin 
You use the Installer program (which is found on the Install Me Fi.rs! disk) to 

install, reinstall , or update system software on a startup disk. When you use 

the Installer, you keep any special files you have installed in your System 

Folder. 

IMPORTANT Before you install a new version of system software, make a 

backup copy of your current System Folder on another disk in case you need 
it later (to use a program that is incompatible with the new system software, 

for example). 

To install, reinstall, or update system software, you need 

• an initia lized hard disk (If you have a hard disk that hasn't been 

initialized- that is, its icon doesn't even appear on the desktop-go to the 

Macintosh Reference book for information on initializing a hard disk.) 

• access to system software (system software disks that came with your 
computer or access to system software over a network) 

Installing system software for the first time 
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If you have a new hard d isk or a newly initialized hard disk that does not 

contain system software, fo llow the steps in this section to do what is 

commonly called a "normal" installation of system software. 

To install from the floppy disks that came with your computer, follow all the 
steps. 

Shut down your computer. 

2 Insert the Disk Tools disk into the floppy disk drive. 

3 Turn on your computer. 

The Disk Tools icon appears on your computer's screen. 



4 Double-click the Disk First Aid icon. 

~I),_ 

~::...bJ 
Disk Fit"st Aid 

Follow the instructions on the screen. Disk First Aid checks your hard drive 

for any problems. 

5 When Disk First Aid has finished checking your hard drive, choose Quit from the File 
menu. 

6 Shut down your computer. 

7 Insert the Install Me First Disk into the floppy disk drive. 

8 Turn on your computer. 

The Installer program opens automatically. 
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9 Click OK. 

The Easy Install dialog box appears. 

C11sy Install 

I
- Click Install to install Uerslon 7.1. 1 or 

Parts of system • PowerBook 500 Serles System Softwore 
Software tO be__,,.........___, o Any [Histing Printing Software 

installed 1 • and olher so ftware. 
I 

t16l(~1n~st~a1~1 JJl/llf_Click to install the 
software you need . 

Disk on which system 
software will be 

installed 

i on the hard disk named 

l. .. ~-':'1-"~~~nsh HO .. .... ·----·-·-..! 
[ 1 J<H t 1Hsk ) Click to install on 
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[ switch Disk)--i-a different disk. 

Help 

( customize_}---t- Click to install 
( ouit ) customized software. 

10 Make sure that the hard disk named in the box is the one on which you want to install 
system software. 

If it isn't, click the Switch Disk button until the correct d isk name appears. 

11 Click Install. 

12 Follow the instructions that appear on the screen. 

If you are insta lling from floppy disks, you see messages ask ing you to insert 
different disks. 

13 When you see a message reporting that the installation was successful, click Restart. 

If a message reports that in stal lation was not successful , try installing again. 
(Follow the instructions o n the screen.) 



Reinstalling system software 

If your system software is damaged, you need to reinstall system software. 
These steps outl ine what is commonly call ed a "clean" installation of system 
software. 

To install from the floppy disks that came with your computer, follow all the 
steps. 

Shut down your computer. 

2 Insert the Disk Tools disk into the floppy disk drive. 

3 Turn on your computer. 

The Disk Tools icon appears on you r computer's screen. 

4 Double-click the Disk First Aid icon. 

L~'J 
Disk First Aid 

Follow the instructions on the screen. Disk First Aid checks your hard drive 

for any problems. 

5 When you are finished, choose Quit from the File Menu. 

6 Double-click the Apple HD SC Setup icon and follow the instructions on the screen. 

~~ 
c=1 

App le HD SC ~3etup 

For more information on using Apple HD SC Setup, see the Macintosh 

Reference book. 

7 Click Drive until the disk you want to update appears. 

8 Click Update and follow the instructions on the screen. 

9 When you see a message that the update was successful, click Quit. 
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10 Check to make sure that at least 5 MB of space is available on the hard disk where you 
want to reinstall the system software. 

Open your hard disk and choose By Icon from the View menu. The amount 
of space available on the hard disk appears in the upper-right corner of the 
wi ndow. If there is Jess than 5 MB of disk space available, delete unnecessary 
files until you have at least 5 MB of disk space available. 

11 Create a new folder named "Old Finder." 

12 Open the System Folder and drag the file called "Finder" to the Old Finder folder. 

13 Rename the System Folder "Storage." 

14 Shut down your computer. 

15 Turn on your computer. 

The blinking question mark icon should appear. 

If you dont see the blinking question mark: If your computer starts up, you 
have another System Folder on your hard disk. Find it (you can use the Find 
command in the File menu), and go back to step 10. 

16 Insert the Install Me First Disk into the floppy disk drive. 

The Installer program opens automatically. 

17 Click OK. 

The Easy Install dialog box appears. 

Easy Install 

p~:;~r~~~eb~ --tt-+[_ ...... --i .. ~.1~~:~i~~~:E;;~~j·:~;~~~~;,~~I~~~;:~~-r:······-- ···-···-··----·---·--···--·-; 
installed I • and other softwore. (( 1nsto11 )J-+-1- Click to install the 

on the hord disk named I l
j i software you need. 

Disk on which system 
software will be --tt,......;-i __ ...... __ =>· ·-~·~.:~~_t_~sh __ ~------------ ·······-------·--.. ·---.. -·--···-··- __j 

installed ( c Jee t llisk ) Click to install on 
( swit ch oisk J--lt- a different disk. 

Help 

l customize _}----1t- Click to install 
( au1t customized software. 
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18 Make sure that the hard disk named in the box is the one on which you want to install 
system software. 

If it isn't, click the Switch Disk button until the correct disk name appears. 

19 Click Install. 

20 Follow the instructions that appear on the screen. 

21 When you see a message reporting that the installation was successful, click Restart. 

If a message reports that installation was not successfu l, try install ing again. 
(Follow the instructions on the screen.) 

After you are fi nished reinstalli ng the system software, make sure that your 
computer star ts up without any problems. Once you know that the new 
software fi xed any problems you were having, you can reinstall any special 
software (control panels, extensions, custom utilities). It is best to reinstall 
application programs from the original (or backup) disks. If you don't have the 
disks, individually copy each control panel, extension, or custom util ity from 
the Storage folder to the System Folder. 

IMPORTANT Be very careful not to replace any of the fi les in the System 
Folder with files from the Storage folder. 

22 When you have reinstalled or copied any special software, delete the Storage folder. 

Installing customized system software 
Custom installation allows you to select just the files you want. You can use 
custom installation to instal l or update a single fi le or to save space on your 
hard disk by installing only the fi les you need. 

Shut down your computer. 

2 Insert the Install Me First disk into the floppy disk drive. 

3 Turn on your computer. 

The Installer program opens automatically. 

4 Click OK. 

The Easy Install dialog box appears. 
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5 Make sure that the hard disk named in the box is the one on which you want to install 

system software. 

ff it isn't, click the Switch Disk button until the correct disk name appears. 

6 Click the Customize button. 

The custom installation dialog box appears. All available components of the 

system software are listed. 

7 Scroll through the list of items and hold down the Shift key as you click the items you 

want to install. 

If you want to conserve space on your hard disk, select the "mi ni mal 

software" option for your computer. 

Click the items yo u wont to selec t; 
Shift - cl ick to select multiple Items. 

System for PowerOook 500 Series 
Min Sys tem for PowerOook 500 Serles 

So ftware for oil Apple printers 

File Sharing Software 
EtherTalk Software 

8 Click Install. 

.Q, 
_ H 

lnS1dll 

= Macintosh HD 

[ l.jtJ&1 lh~k ) 

( Switch Disk ) 

(Easy Install ) 

Quit 

9 Follow the instructions that appear on the screen. 

If you are installing from fl oppy disks, you may see messages asking you to 

insert different disks. 

10 When you see a message reporting that the installation was successful, click Restart. 

If a message reports that installation was not successful, try installing again. 

(Follow the instructions on the screen.) 



Appendix B 

Refer to this appendix when you 

want to use the PowerBook File 

Assistant that came with your 

computer to synchronize files. 

Using the PowerBook File Assistant 
• • • • • • 

The PowerBook File Assistant is software that synchron izes files on your 

PowerBook and desktop Macintosh by automatically updating fil es whenever 
you make changes. With File Assistant, you can always be sure that the fi le 

you are working on is the current version. 

What is file synchronization? 
As a user of both a desktop Macintosh and a PowerBook, you may ofte n have 
the same fil e or fo lder on both computers. But you may have a problem 
keeping track of what files are on what computer. 

The PowerBook File Assistant keeps the most recent version of a file o r 
folder on both your desktop Macintosh and your PowerBook. T he process of 

updating the fi les on both computers is ca lled .file synchmnization. With the 
PowerBook File Assistant, you can sy nchronize individual fil es or folders. 
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Starting the PowerBook File Assistant 
Once you have installed the PowerBook File Assistant, you are ready to 

decide which files you want to synchronize. 

• Double-click the PowerBook File Assistant icon. 

Po\verBook File Assistant 

The File Assistant Setup window appears: 

U3 :cs Fiie Assistant Setup rai! 

CJ a ~ 
~ 

no item selec ted no ittm n lecte-d 

St~tus : No itffnS t>av• bttn stleeted 
L~st Sljnohronizod: Nt vtr 

1:1 
¢ =r ! i_ lQ l!i 

Linking files or folders for synchronization 
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Before you can sy nchronize fil es or folders, you need to link th em. Linking 
joins two identical copies of a fil e or folder together so that when one fi le or 
folder in the pair is modified, the linked fi le or folder is also changed. 

IMPORTANT Files cannot be linked if they are not identical copies. 

Before lin king, make sure that each computer's clock is set for the same time 
and date. See the Macintosh Reference book that came with your computer for 
information on how to set the time a nd date on your computer's clock. 



To lin k fi les or fo lders, follow these steps: 

Drag an icon of the folder or file you want to link to a selection box in the File Assistant 
Setup window. 

fole Asslstonl Setup 

The item selection 

I I ~ no 1t tm ultcttd 
.. 

lftijfttilfjfflltjl on either side of th 
box is this area 
earrow 

Status No rttmS ~v• bf«\ ultettd I ~ '--- Drag the icon of th Y.st &Jnchron\ttd . Hn ff' 

synchronize to the 
. llil Desktop Moclntosh F.IJ; 

2' lttms 639M8in dbk 12 9 MB .tv• 116b ... 

CCJ u.m,l1ram CJ ~ 
f-

SVsttm roldtf" ApphcatlMJ 

6 CJ 6 . -
Mtmo to .Jtff Hok1t 1994 ~t f1J.s K. Hts ttr's ~1-lf"'\I Rtvlt_. 

'i" 
~II J:9 l!l 

2 Drag the matching icon to the other selection box. 

e file you want to 
item selection box. 

Once you have two matching files or folders in the Setup window, you have a 
linked pair. Another pair of selection boxes appears. Repeat steps l and 2 to 
lin k more pai rs of fil es or folders. 

The setup screen grows as you add to the list of lin ked pai rs. Use the scroll 
bars on the right of the screen to see the part of the list that is not in view. 
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Setting the direction of the link 

Notice the arrow between the two linked fil es; thi s is how you can tell the 

direction in which the fi les are lin ked. Normal ly the PowerBook File 

Assi tant synchronizes fi les in both directions, but you ca n set the direction to 

be one way, from ei ther left to right or right to left. 

A one-way link is helpful if you want to receive updated versions of a 

document from a fil e server on a network. 

Click the pair of linked files you want to synchronize one way to highlight it. 

Click in the item selection box f'or e ither file or folder in the pair. 

2 Choose the direction you want from the Synchronize menu. 

Synchronize 

Syn chronize Now WG 

./Manual :ICM 
Automatic X T 

Choose two-way-+- ..,. Two w ay 31: = 
synchronization 
to update either ./ -+ Left To Right ii 

file when the t- Choose one-way synchronization to update 
corresponding file in +- Right To Left :IC[ a file on your hard disk from a network server. 

the pair changes. -= 
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The d irectio n of the arrow be tween the two li nked fi les in the Setup window 

changes to reflect your choice. 

The arrow changes to indicate the direction of the link. 

[1j => B 
lttter to Romtro lttltt to Romero 

<=I 0.sktop Macintosh ~PowtrBook 

Status : Th~ itt ms havt l\Ot btt n synchronized 
LH\ S\i nchronized : l~tVtr 



Linking non-matching folders 

PowerBook File Assistant lets you synchronize folders that have different 

names and contain di fferent files. 

Choose Preferences from the File Menu. 

T he following dialog box appears: 

U PowerBook File Assist ant Pre fer ences 

Click here to be able --11___,,_1~ .1A.11ow non- mat ching f older names 

to link folders with "' 181 Warn when can' t synchroni ze 
different names. 

181 Worn before dele t ing 

( Cancel) (~J 

2 Click the checkbox to allow non-matching folder names. 

3 Click OK. 

Now you can link fo lde rs that have di fferent names and contents. The fi rst 

time you synchroni ze a pair of non-matching folders, PowerBook File 

Assista nt copies all the files from one folder to the other folde r, so that the 

folders have identical contents. 
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Deleting a linked pair 

If you don't want to synchron ize a 1 in ked pair anymore, you can dele te the 

linked pair from the Setup wi ndow. 

Click the pair you want to delete to select it. 

To select more than one pair, hold down the Shift key and click other pairs. 

To select a ll pairs, choose Select All from the Edit menu. 

2 Choose Delete Pairs from the Edit menu. 

The pairs you selected are deleted from the Setup w indow. 



Synchronizing linked folders or files 

The name of the disk 
appears here. 

To synchronize fil es or folders you linked in the Setup window, you must do 
two things: 

• Connect the disks containing the fil es you are synchronizing. 

• Open the PowerBook File Assistant. 

Now you are ready to synchronize the lin ked fi les or folders. Any time you 
make a change to either item, the same change is made to the linked item. If 
an item is deleted, you' ll be asked to confirm that you want to delete the 
corresponding fi le or folder. 

Information about each lin ked pair is d isplayed in the Setup window. 

~liJ v= Fil e Assistant Setup 

1993 Bud9et Updates 1993 Bud9et Updatos 

c:;:t PowtrBook cz;:> Oesk1op Macintosh 

Status: TM fttms h.ave bttn synchronized 
Last S..,nohroniud: Mon, May 3, 1993, 2:47:46 PM-----+.....1- If the files have been 

Lethr to Romero 

c:> Desktop Mocinlosh 

~ 
§! 

l etter to Romero 

EZ::l Po'tllerBook 

St...tus: Thf' ittrns have not ~tn ~nchronized 
Last Synchroniz:td: Never 

synchronized, the time 
and date appear here. 

You can set Powe rBook File Assistant to synchronize fi les either manually or 
automatically. You choose which you want when you link the ite ms. 
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Manual synchronization 

When you choose manual synchronization, you decide when you want to 

update a linked pair. 

Select a pair, then choose Manual from the Synchronize menu. 

2 Click the arrow in the File Assistant Setup window. 

Ch 
D 

1993 Budget Updates 

Click the arrow to synchronize the pair. 

1993 Budget Updates 

A message appears te lling you that the files are being updated. 

You can a lso manually update files that are linked by selecting the pair and 

then choosing Synchroni ze Now from the Synchronize menu. 

Automatic synchronization 

To update lin ked fil es automatically whenever a change is made to either of 

the linked files: 

• Select the pair and then choose Automatic from the Synchronize menu. 

A message appears whenever fil es are being updated. You can also set 

pai rs to be updated every time you connect with another disk. See "Setting 

Completely Automatic Synchroni zation" later in this Appendi x. 



Understanding the alert messages 
As you synchronize linked pairs, the PowerBook File Assistant displays alert 
messages about the synchronization. You can turn off the alert messages by 

followi ng these steps: 

Choose Preferences from the File menu. 

A dialog box appears. 

2 Click the "Warn when can't synchronize" checkbox to deselect it. 

The messages do not appear. 

If you don't want the alert message to appear when a file or folder is put in 
the Trash, click the checkbox next to "Warn before deleting" to deselect it. Be 
very careful if you turn off the alert message that warns you when fi les are 

put in the Trash. Items are put in the Trash during synchronization whenever 
a lin ked item is deleted or renamed. 

3 Click OK. 

Alert messages are turned off. If you want to turn them back on, choose 
Preferences from the Fi le menu and click the checkboxes again to reselect 
them. 

To turn alert messages off temporarily, hold down the Option key. While you 
hold down the Option key, the alert messages for any commands you execute 

are turned off. 
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The PowerBook File Assistant needs to be running in order to synchroni ze 
your fil es. To set up your system to automatically synchronize linked files: 

Select the pair and then choose Automatic from the Synchronize menu. 

2 Use the AutoRemounter control panel to reconnect to shared disks. 

See Chapter 7 for instructions on automatically reconnecting ("remounting") 
to shared disks. 

3 Drag an alias of the PowerBook File Assistant icon to the Startup Items folder. 

T he Startup Items folder is in your PowerBook's System Folder. 

See the Macintosh Reference book for help on creating an alias. 

~ ~stem fo lder 
!lJ!!!t s~. KV>d '""' I> D Applt Mtnu 1ttms - foldtr' - i! 

I> Cl Control P.Mlt ls - foldtr - r-I> Cl Ex lt nsions - foldtr -
Or~r 552K f>I• -

~ ar~ts - foldoff' -
~Cl Pr•ftrtneH - foldtr -
I> D Sbrtup lttms - fold.,,. -~ 
tii1 2. .J.• Ql 

Now whenever AutoRemounter mounts your volumes and the PowerBook 
File Assistant is running, all automatically linked pairs are synchronized. 



Appendix C 

Refer to this appendix for 

information on using the Macintosh 

PC Exchange program that came 

with your computer. 

Exchanging Files With DOS or Windows 
•••••• 

Macintosh PC Exchange is software included with your computer that lets 
you easily exchange documents between your Macintosh and a DOS or 
Windows computer. You can use Macintosh PC Exchange to create floppy 
disks compatible with DOS computers. 

Macintosh PC Exchange at a glance 

Using the 
PC Exchange control 

panel, you can specify 
which Macintosh 

programs are used to 
open DOS documents. 

You can open, edit, and save DOS documents using 
your favorite Macintosh application programs. 

[~u119r,,,,.ntbooleW" .,•\•rmY1tJW'l'l'letl 
H.Kinlo1'1 ~pllnHon fl'OJYllm lJ ,.Jt~ wl'ttn 

1100~ DOS OXl.l'IWnt s vi\~ t p.,.t~'Yhr 111fnx 

. . . as this type of document. 

CD C 

You can use and create 
DOS-format disks. 
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Using DOS-format disks on your Macintosh 

148 Appendix C 

The format of a disk refers to the way the computer prepares the disk to 
receive information. Maci ntosh computers and DOS computers use different 
disk formats, but with Macintosh PC Exchange installed in your Macintosh 

system, your Macintosh ca n read disks of either format. 

To use a DOS-format disk on your Macintosh, simply insert the disk into your 
computer's floppy disk drive. The disk's icon appears on the desktop. You can 
open the disk by double-clicking its icon- the same way you wou ld open an 
ordinary Macintosh disk. 

When you insert a DOS-format 
floppy disk, you see this icon. 

If you see a message that the disk is unreadable, see Chapter 12 of this book. 

WARNING Do not attempt to repair a DOS-format disk using disk repair 
utility programs intended for use on the Macintosh. Doing so is likely to 
destroy any information on the disk. If you must repair a DOS-format 
floppy disk, use a disk repair utility on your DOS computer. 



Creating a blank DOS-format disk 

When you erase or ini tiali ze a disk on the Macintosh, you can choose its 
format-either Macintosh or DOS. 

WARNING Before you erase or initialize a disk, be sure that the disk 
contains no information you want to save. 

To create a blank DOS-format disk on your Macintosh, follow these steps: 

1 Insert a floppy disk. 

• If the disk has not been initialized, a dialog box appears in which you can 

specify the disk's name and format. 

I' -.-1 This disk Is unreadable by this M11clntosh. 
Do you wont to lnltlallze the disk? 

Nome: ~I iiiiliii[iii[iii[iii[iii[iii[i. 
Format: I Macintosh 1.4MB .., I 

~ Ejec t J [ I nitlalize J 

• If the disk has already been used, you' ll need to erase it. Select the disk, 

then choose Erase Disk from the Special menu. 

Clean Up Desktop 
E:mptq 'fmsh ... 

Eject Disk 3CE 
Erase Disk ... 

-·-··-··-·-·-·--····-·······-·········-·····~-·-· 
Restart 
Shut Down 
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A dialog box appears in which you can specify the disk's name and format. 

I -,1 Complet ely erose disk named 
" Homework" (intemol drluel? 

Nome: ~I ~mii!ii!ii!ii!ii!iiiil 
Format: I Macintosh 1.4MB ""'l 

([ Cancel )J [ Erase 

2 Type a name for the disk. 

3 Choose the disk format you want from the Format pop-up menu. 

The list of available formats varies depending on your disk drive and the 
capacity of the disk. Choose DOS if you plan to use the disk on both 

Macintosh and DOS computers. 

I - ,1 Completely erase disk named 
" Homework" (Internal drlue)7 

Name: I , · • 

4 Click Erase (or Initialize). 

Erase 

If you're initializing a disk, an alert box appears. C lick the Continue button. 

The Macintosh prepares the disk in the formac you chose. 

Usually it takes less than a minute to initialize or erase a floppy disk. 
However, if portions of the disk have been damaged, the initialization process 
may take several minutes. 

If you changed the disk's format, the disk's icon will change when you 
re-i nsert the d isk. 



Opening DOS documents on your Macintosh 

Opening a document from within a Macintosh program 

The surest way to open a DOS document on the Macintosh is to use the Open 
command from wi thin an application program. 

1 Open the program you want to use. 

2 Choose Open from the File menu. 

Close 
Saue 

3€W 
3€S 

A directory dialog box appears. 

lei Rldus SuperPolnt 3.0 •) 

D BfrW EPS Files 
D Color EPS Fil es 
D Reed Me Folder 
D Semple Images 
D SP Pouch 
D Tutor lol Files 

-0 = Hard disk 

I c1en I 
( Desktop J 

Many programs have buttons or pop-up 
menus that let you open or import 

rormots ... f------------+1--documents of a particular fi le format. 

H Open D 
L..__--------~'° ( Cancel ) 

Selec l ed type: 

3 Select the document you want, and click Open. 

If you have problems opening the document, see Chapter 12 of this book. 

Opening a document by double-clicking its icon 

Before you can open a DOS document by double-clicking its icon, you need 
to use the PC Exchange control pane l to specify which Macintosh application 

programs will open DOS documents, as described in the next section. 
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Assigning Macintosh programs to DOS documents 
Using the PC Exchange control panel, you can assign Macintosh application 

programs to DOS documents. For example, you can specify that all DOS 
documents whose fi lenames end with the suffix .XLS are to be opened in the 
Macintosh program Microsoft Excel. 

The figure below shows the PC Exchange control panel with some 
assignments already created. 

ID PC £11change 
E•ch .assignment below dt termints ""'Mch 

Macintosh ~pplication program is un d -whtn 
\jOU optn 005 documents '\lfith a particular su(fl>< . 

~ Applicoitlon Pr09ram Documtnt T~pt 

.DOC ·--~ Mic~~~:~---·----~--~.~~.-- .. -~ 
PM4 

TKT 

'111(3 

DOS documents--+ )(ls 
whose names end 

with this suttix ... 
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( Add... J [ [hnnge ... J ( Remo •c~ J 

... are to be opened 
by this Macintosh 
program ... 

... as this type 
of document. 



Before you can assign a Macintosh program to a group of DOS documents, 
there are three questions you need to answer: 

• What suffix do the documents have in common? 

Many DOS programs automatically add a three-letter suffix (or filename 
extension) to a document's name. For example, these PageMaker documents 
all share the suffix .PM4: 

NEWS.PM4 
REPORT.PM4 
RESUME.PM4 

• What Macintosh application program do you want to use to open the documents? 

Each Macintosh document has a creator-that is, the Macintosh program 
used to create the document. When you double-click a document's icon, 
the Macintosh opens the program that created the document. 

Using the PC Exchange control panel, you can assign Macintosh programs 
to DOS documents as "creators." 

• What type of document is it? 

Most programs are able to open or import some, but not all, types of 
documents. A document's type is a three- or four-letter code (such as 
TEXT or PICT) that tells a program whether or not it can recognize the 
document. A program displays documents of types it can recognize in its 
directory dialog box. 

Unless you specify otherwise, the Macintosh assumes that all DOS 
documents have the document type TEXT. You can assign different types 
to some DOS documents. See the next section. 

A document's type is different from its file forma~ which refers to the way 
information within the document is encoded. If a program is unable to 
accurately interpret a document's file format, the document's formatting may 
be displayed incorrectly. (To find out which file formats a program can 
understand, refer to the documentation for the program.) 
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Recommended assignments for some widely used application 
programs 

The information in this section will help you assign documents from some 
widely used DOS/Windows programs to some widely used Maci ntosh 
programs. (For more information, see the documentation for your application 

programs.) 

AMI Pro (Windows), version 2.0 

Documents in AMI Pro (Windows) version 2.0 are automatically saved with 

the suffix .SAM. 

To open these documents on the Macintosh, add one of the following 
assignments to the PC Exchange control panel: 

DOS Suffix Macintosh application Document type 

.SAM lll MacWrite~ II (version 1.1) ~ TEXT 

.SAM ii? Microsoft Word (version 5.0) II TEXT 

.SAM s WordPerfect (version 2.0) -TEXT 

.SAM ~ WriteNow (version 2.2) il TEXT 

Lotus 1-2-3 (Windows), version 1.0 

Documents in Lotus 1-2-3 (Windows) version LO are automatically saved with 
the suffix .WK3. 

To open these Lotus 1-2-3 documents on the Macintosh, add one of the 
following assignments to the PC Exchange control panel: 

DOS Suffix Macintosh application Document type 

.WK3 ~ Lotus 1-2-3 (version 1.0) D TEXT 

.WK3 ~ Microsoft Excel (version 3.0) ~ TEXT -



Microsoft Excel (Windows), version 3.0 

Documents in Microsoft Excel (Windows) version 3.0 are automatically saved 
with the suffix .XLS. 

To open these M icrosoft Excel documents on the Macintosh, add one of the 
fo llowing assign ments to the PC Exchange control pane l: 

DOS Suffix Macintosh application Document type 

.XLS ~ Lotus 1-2-3 (version 1.0) D TEXT 

.XLS ~ Microsoft Excel (version 3.0) ~ TEXT -

Microsoft Word (Windows), version 2.0 

Docu ments in Microsoft Word (Windows) version 2.0 are automatically saved 

with the suffi x .DOC. 

To open these documents in Microsoft Word (Macintosh) version 5.0, add the 

following assignment to the PC Exchange control panel: 

DOS Suffix Macintosh application Document type 

.DOC <f/j- Microsoft Word (version 5.0) ~ WDBN 

PageMaker (Windows), version 4.0 

Documents in PageMaker (Windows) version 4.0 are automatically saved with 

the suffix .PM4. 

To open these documents in PageMaker (Macintosh) version 4.0, add the 
fo llowi ng assignment to the PC Exchange control panel: 

DOS Suffix Macintosh application Document type 

.PM4 g. PageMaker (version 4.0) B ALB4 
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Quattro (DOS), version 3.0 

When saving documents in Quattro (DOS) version 3.0, be sure to save them 
with the suffi x . WK J (rather than the default suffi x, . WQ 1 ). Quattro saves 
documents ending in .WKI in the Lotus 1-2-3 file format, which can be 
interpreted by many Macintosh spreadsheet programs. 

To open these Quattro documents on the Macintosh, add one of the following 
assignments to the PC Exchange control panel: 

DOS Suffix Macintosh application Document type 

.WK1 ~ Claris Resolve'" (version 3.0) ~ TEXT . 

.WK1 ~ Lotus 1-2-3 (version 1.0) D TEXT 

.WK1 ~ Microsoft Excel (version 3.0) ~ TEXT -

Ventura Publisher (Windows), version 3.2 

Documents in Ventura Publisher (Windows) version 3.2 are automatically 
saved with the suffix .CHP. 

To open these documents in Ventura Publisher (Macintosh) version 3.2, add 
the fol lowing assignment to the PC Exchange control panel: 

DOS Suffix Macintosh application Document type 

.CHP .... Ventura Publisher (version 3.2) ~ VCHP 

WordPerfect (DOS), version 5.1 

WordPerfect (DOS) version 5.1 , does not automatically add a suffi x to the 
names of documents. The easiest way to open WordPerfect (DOS) documents 
on the Macintosh is by choosing the Open command from within an 
application program. 



Adding an assignment to the PC Exchange control panel 

To add an assignment, follow these steps: 

Choose Control Panels from the Apple {ti) menu. 

The Control Panels window opens. 

2 Open the PC Exchange control panel. 

Double-click the PC Exchange icon, or select the icon and choose Open from 
the File menu. 

PC Ex change 

The PC Exchange control panel appears. 

ID PC [HChDll[C 

Each usi9nmfnt btlow df'ttrmVlts >ithKh 
H.cWltosh "PS!Hc1tion Pt'"091"~ ts uud -.;hfn 

\IOU~ DOS ®'U"ntnls "'1th i p•hcu1ar suffoc. 

~ Applfc•tlon Progr"am Oocumf'nt TtJp• 

~ 

'o 

( Rdd ... l (I h11ng1~ ... ) ( flmno1•c l 
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3 Click the Add button. 

Add ... ~) 

A dialog box appears in which you can specify a DOS suffix and its 

corresponding Macintosh application program and document type. 

Assign on applica tion to o OOS suffl11: 

[~-~:7.::7.::~-~ 
I~ Applications folder ...,. I = Hard disk 

O Cl8rls Software {l, £j er.1 
o compuSerue r-o Oestgn '09 [ Desktop ) 
0 Olslnfectant folder -·-··--·--·----
0 Fourth Dimension 
O Mac I n TaH [ Cancel ) 
~ MocWrite 
<31 Microsoft [Heel 'O l( OK l) 

4 Type a three-letter DOS suffix in the DOS Suffix box. 

Assign on opplicotion to a DOS suff111 : 

OOS $ufil)( - - AppUc~hon Pr09f"Mn --l>ocOO\t'flt Ty" 

~ ~(Not specHted) If J--- •] 

To speci fy which Maci ntosh program will open DOS documents with no 

suffix, click inside the box to set the insertion point, but leave it blank. 



5 Select a Macintosh application program from the lower section of the dialog box. 

Rssign 11n uppllc11tion to 11 DDS surfiH: 

I DOS Suffuc --Appllc• Uon Pr"9'"" --Ooc..,_t T~po =il 
L [§0 ~ MecWr lte l[lJ TEHT ] 

lesi Rppllcotlons folder• l = Hord disk 

Eject 

Desktop 

D Cloris So rtw11re ff. 
D CompuServe 

I-:: D Design '89 
•':::1 D Dislnfect ont folder 

( Cancel l 
D Fourth Dimension 
D Moc In TllH 

~ Microsoft EHcel ~ 0 I! DK ~ 

6 Choose a document type from the Document Type pop-up menu. 

Document types are indicated by icons and four- lette r codes whose meanings 
are seldom obvious. For help choosing the correct document type, see the 

information in the previous section, "Recommended Assignments for Some 
Widely Used Application Programs." 

If you don' t know which document type to choose, try TEXT. 

7 Once you've specified a DOS suffix, a Macintosh application program, and the 
appropriate document type, click OK. 

T he assignment is added to the list in the control panel. 

Exchanging Fi les with DOS or Windows 159 



Trying out an assignment 

To try out an assignment you've added to the PC Exchange control panel, 

follow these steps: 

Insert a DOS-format floppy disk and open its icon. 

PC Exchange assignments take effect whe n you insert a floppy disk, or when 
you open a DOS-format floppy disk. (If th e disk window was already open, 
you need to close it and open it again.) 

2 Double-click the icon of a DOS document whose filename ends with the suffix you 
specified. 

To sort the list of 
assignments, click 

a category. 
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The document is opened by the appropriate Macintosh application program. 

(You might see a message that the document's file format is being converted.) 

If you have problems opening documents, see Chapter 12 of this book. 

Editing the list of assignments 

You can change, remove, and sort assignments in the PC Exchange control 
panel. 

PC EHchon e 
Etch HSlQt"ll"Mnt lwlow dt ttrmints 'llfMCh 

Mt0inlosh .1pp1ic1tlon pr04Y•m Is und w~n 
~ou ~DOS doc!Jl'Mnts 'With .., ~rUc.ular suffbc . 

<i> H1erosoft 'Word • \t'OllN {} 
1----

.XLS 

. p~ ..... o II ALB• 

~-M-icr_os_oft_E•_c•_I __ II_ ~LS 

Add ... Chonge ... Remoue To remove an assignment, select it 
in the list, then click Remove. 

To change an assignment, select 
it in the list, then click Change. 



Sharing assignment lists with other users 

The list of assignments is stored in the PC Exchange Preferences file. This 

file is stored in the Preferences folder inside the System Folder. 

D 
PC Exchange Pt·eferences 

You can make sure that every licensed user of Macintosh PC Exchange in 
your office uses the same assign ments. Make copies of the PC Exchange 
Preferences file and place one copy in the Preferences folder (inside the 
System Folder) of each licensed user's Macintosh. 

Do not change the name of the PC Exchange Preferences file. 

Saving documents onto a DOS-format disk 
You save documents onto a DOS-format disk the same way you save them 
onto a Macintosh disk-by choosing the Save command from the File menu. 

IMPORTANT Be sure to leave at least SK of extra disk space when you save or 
copy files onto a DOS-format floppy disk. (The Macintosh needs this space to 
store Macintosh-specific information about files on the disk, such as the 
location of icons and windows on the Macintosh desktop.) 
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The Save As dialog 
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buttons or pop-up 
menus for choosing 

a file format. 
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Choosing a file format 

In some programs you' ll have the choice of saving the document in one of 

several file formats. 

I~ To-prod •I 
Cl llrt U~t 
D llm~•~ns lo f'1 odtu lion 
D Screens ( l 00'7.) 
D Screens (with ca llouts) 

Saue Current Oocumont as: 

jMemo.doc 

D rus1 s1wl' D Mnke Bockup 

File Format... Normal 

= H11rd disk 
21 l 9K nunilnble 

~~ 
( Cancel J pesktop) 

A document's file fo rmat refers to the way information within the document is 
encoded. If a program cannot accurately interpret a document's file format, it 
may display the document incorrectly (as in the figure below). 

!!DE ES:I Untitled BJ! 
OOOOOOOA document's ftle f orm11t re f ers to the Q 
wey informeuon wilhtn the document ts encoded. If H 
e progrem cennot eccuretely interpret e document's 
r11e rormet. ll mey be uneble to open the document. 
or 11 mey not be eble lo eccurolely interpret the 
rormolling codes in the document (es in the figure 

Qj below).00000 
'2l 

When you save a document that you plan to use with another program, be 
sure to save it in a fi le format that the other program can understa nd. (To find 

out what file formats a program is able to open, import, and save, see the 
documentation you received with the program.) 

Naming files for use on both Macintosh and DOS computers 

On DOS computers, fi le names are li mited to eight characters (plus a three­
lette r suffi x) and may not contain spaces. The rules for naming Maci ntosh 
files are less restrictive. Therefore, when working on the Maci ntosh, it's 
possible to give a fi le a name that would be " illegal" on DOS computers. 



For example, suppose you created a fil e on your Macintosh named 

July Budget.DOC 

If you viewed the same file on a DOS compute r, its name would be 

!JUL YBUD.DOC 

The exclamation mark(!) indicates that the name has been shortened. 

A fi le can thus have two names: a long name (for when the file is displayed 
on the Macintosh) and a short name (for when it's displayed on a DOS 
computer). 

Whi le using a DOS- format floppy disk on the Macintosh, you can see a 
document's short name by selecti ng the document, choosing the Get·In fo 
command from the File menu , and clicking the document's name in the Info 
dialog box. (For this procedure to work, you must have the File Sharing 

Extension installed .) 

Long name 

!!OEiil July Bud et.WKS Info ~ 

[I) Ju.,~9tt DOC 

Ktnd : Mac'Writ• doc.ormnt 
Size : 10Kondisk(9,793bytu ustd) 

Short name 

Kind : Mae'Wn lt doc.umtnl 
Sfu : I OKond1.sk(9,783bvtuustd) 

Viewing the contents of a disk on your DOS computer 

When you view the directory of a disk on your DOS computer, you might 

notice additional directories named RESOURCE.FRK. These directories 
contain important information, known as resources, which are contained in 

some Macintosh documents. 

WARNING Do not delete or move any directories named 
RESOURCE.FRK, and do not move any fi les out of these di rectories. 
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A 

About This Macintosh (Apple 
menu) 110 

AC power 63 
Active windows 31, 37 
ADB devices 

connecting 108 
power consumption of l 08 

ADB port 105, 108 
Airline travel, security and 

restrictions 85 
Alert messages (PowerBook File 

Assistant) 145 
AMI Pro 2.0 (Windows) 154 
Apple Desktop Bus. See ADB 
Apple HDSC Setup icon 133 
AppleTalk 127. See also networks 

Phase 1 and Phase 2 protocols for 
Ethernet 112 

printing on 84 
turning connection on and off 61-62 

AppleTalk Switch module (Control Strip) 
61-62, 127 

Application menu 42 

Application programs 
assigning to DOS documents 

152-160 
opening documents from within 38 
opening DOS documents from within 

151-152 
troubleshooting 128 

Arms, discomfort in 51 
Arrow keys 43 
Assigning Macintosh programs to DOS 

documents 152-154 
Audio input and output J 08 
Automatic fi le synchronization 146 
Automatic power conservation, 

controlling 74 
Automatic sleep 7, 64, 70 

messages prior to 64 
recharging batteries after 68 
troubleshooting 119 

AutoRemounter control panel 77 

B 

Backing up System Folder 130 
Backlighl dimming. See screen dimming 
Balloon Help 53 
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Batteries 46, 56, 58, 63-74. See also 
Control Strip; power 

bums from 67 
caring for 47 
charge level of 56-58, 64 
charge, life of 57, 63, 69-70, 72-73 
charging I, 57, 63 
conservation settings 69, 71, 73-74 
conserving power of 59, 68-70, 

72-73 
consumption rate of 57 
damage to 65, 67 
discarding 67 
discharging 68 
door on 66 
environmental hazards from 67 
estimated work time remaining 57 
handling 45, 47 
hard disk consumption of 59 
low-power messages 64 
recharging 45-46, 63, 65-66, 68 
recycling 47, 67 
removing or replacing 66-68 
SCSI disk mode and 95 
transporting 85 
troubleshooting 119 

Battery Conservation section 
(PowerBook control panel) 
68-70, 72-73 

adjusting settings 69-71 
Custom options 72 
customizing 73 

Battery icons 57 
Battery Monitor module (Control Strip) 

56-58,65-66,68 
customizing 58 

Battery terminal, short-circuiting 46 
Blinking question mark icon 5, 120, 

129, 134 
Brightness control 5 
Bums from batteries 67 

c 
Cables 

Ethernet 113-114 
HDI-30 SCSI System Cable 87, 

91-92 
safety and 45, 91 
SCSI Disk Adapter cable 93-95 
SCSI peripheral interface cable 91-92 
video 99 

Cancel button 31 
Caps Lock key 43 
Care and safety instructions 45 
Chair, position of 50 
Character key 42 
Charging batteries l, 45-47, 57, 63, 65 

troubleshooting 119 
Chooser 126-127 
Cleaning the Power Book 4 7 
Close box 21, 31 
Close command (File menu) 38 
Closing 

Control Strip 12, 54 
documents 25, 38 
windows 31, 36 

Clues on your screen 30-31 
Command key 43 
Connecting 

ADB devices 108 
to Ethernet 111-114 
external modem 106-107 
external monitor 98 
mouse 108 
power adapter 1-2 
PowerBook between two devices on 

Ethernet 112 
printer 107 
SCSI devices 87-96 
SCSI disk adapter cable 94-95 
sound input devices 108-109 
sound output devices 109 

Connectors 46 
Conserving battery power 59, 68-69, 71, 

73-74 



Contrast control 5 
Contrast, screen 5, 51 
Control key 43 
Control panels (Apple menu) 

AutoRemounter 77 
Battery Conservation options 69-74 
for external modem setup 106-107 
for RAM disk setup 78-8 1 
for set as SCSI disk 93-94 
Memory control panel 78-81 
Monitors control panel 99-101 
opening 69 
PowerBook Display control panel 103 
PowerBook Setup control panel 

93-94, 106-107, 125 
processor cycling options 73 
Startup Disk control panel 81 
Trackpad control panel 76 
vs. Control Strip 54 

Contro l Strip 53-56, 58-62. See·atso 
batteries; power 

appearance of 53 
AppleTalk Switch module 61-62, 127 
battery conservation settings 58 
Battery Monitor module 56-58, 

65-66, 68 
closing 12, 54 
customizing 58 
File Sharing module 60 
HD Spin Down module 59 
hiding and showing 55 
location of 12 
moving 56 
opening 54 
power 53 
Power Settings module 58, 69, 72-74 
purpose of 53 
rearranging modules in 56 
resizing 55 
Sleep module 70-71 
Sleep Now module 59 
Sound Volume module 61 
Video Mirroring module 62, 103 
vs. control panels 54 

Copying 
floppy disk contents 40 
icons 35 

CPU, processor cycling and 73 
Creating 

documents 22- 27 
files 22- 24, 26-27 
folders 26, 41 

Cumulative trauma disorders (CTDs) 48 
Custom options for battery conservation 

70, 72-73 
Customizing 

Battery Conservation section 
(PowerBook control panel) 
72- 74 

Battery Monitor module (Control 
Strip) 58 

D 

PowerBook 75- 76, 83- 84 
system software 135-136 

Delete key 43 
Deleting items from hard disks 

28- 29,36 
Desktop 

appearance of 20 
organizing 41 
removing Control St1ip from 55 

Dialog boxes, keyboard shortcuts in 42 
Dimmed commands 42 
Dimming screen 

on external monitor l 02 
on PowerBook 69, 7 1 

Directory dialog boxes, keyboard 
shortcuts in 42 

Discarding batteries 67 
Disk drives 

external, using PowerBook as 94 
troubleshooting 122 

Disk First Aid icon 131, 133 
Disk formats 148 
Disk Tools disk 130- 131 , 133 
Disk Tools icon 130, 133 
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Disks. See also floppy disks; hard disk; 
RAM disk; shared disks 

menus of 39 
opening higher levels of 37 
troubleshooting 122-123 
working with 40-41 

Display. See also monitor, external; 
screen 

angle of 3 
opening 3 

Documents 38-39. See also files 
closing 25, 38 
creating 22-27 
deleting with Trash 28-29, 36 
DOS 147 
naming 23-24, 39 

for use on Macintosh and DOS 
computers l62 

opening 38 
saving 23-24,39, 125 

in folders 39 
onto a DOS-format disk 161 

storing in folders 26-27 
types of l53 
working with 38-39 

DOS documents 
assigning Macintosh programs to 

152-158, l60- 161 
opening on a Macintosh 15 l 

DOS, exchanging files with 147 
DOS-format disks 148-150 

erasing 149-150 
formatting 150 
icon for 148 
initializing 149-150 
repairing l48 
saving documents onto 161- 162 
viewing contents of on DOS 

computer 163 
DOS suffixes 152-156, 158-159 
Double-clicking 13, 38 

changing speed of 76 

Dragging 

E 

Control Strip 56 
Control Strip modules 56 
icons 35 
items from screen to external 

monitor 97 
items to folders 27 
items to Trash 28 
window size box 36 

Editing text, with Delete key 23 
Ejecting floppy disks 40 

troubleshooting 124 
Electrical hazards 45 
Electromagnetic emissions 52 
Emptying Trash 29, 36 
Erase Disk command (Special menu) 41 
Erasing floppy disks 41, 149-150 
Erasing items from hard disk 28- 29, 36 
Error messages 94, 126. See also 

troubleshooting 
after connecting SCSI chain 94 
system error 7 
when printing 126 

Errors, correcting with Delete key 23 
Escape key 43 
Ethernet 111-114 
Ethernet adapter 111- 114 
Ethernet cable 1 13-114 
Ethernet network 111-114. See also 

networks 
connecting directly to printer 

with 114 
connecting PowerBook between two 

devices on 112-113 
connecting PowerBook to end of I 13 
protocols for 112 

Ethernetport 105, 107, 111-112, 114 
EtherTalk l 11-112 
Exchanging files with DOS or 

Windows 147 



External modem. See modem, external 
External monitor. See monitor, external 
Eye fatigue 49 

F, G 

Fatigue, avoiding 52 
File sharing 60 
File Sharing module (Control Strip) 60 
File Sharing Setup control panel 60 
File synchronization 

alert messages for 145 
automatic synchronization 144, 146 
deleting a linked pair 142 
linking files or folders for 138-139 
linking non-matching folders 141 
manual synchronization 144 
purpose of 137 
setting the direction of the link 140 
synchronizing linked folders or 

files 143 
Files 

closing 25, 38 
creating 22-27 
deleting with Trash 28-29 
DOS 147 

opening on a Macintosh J 5 J 
exchanging with DOS or 

Windows 147 
linking for synchronization 138-139 
locked 124 
naming 23-24,39, 162 
opening 38 
saving 23-24, 39, 125 

onto a DOS-format disk 161 
sharing 60 
storing in folders 26-27 
synchronizing between PowerBook 

Finder 

and desktop Macintosh 
137-146 

keyboard shortcuts in 42 
returning to 30 

Floppy disk drive, troubleshooting 123 
Floppy disks 40-41 

as startup disk 129 
copying contents of 40 
copying contents to another disk 40 
DOS-format 147, 149-150. See also 

Macintosh PC Exchange 
ejecting 40 

troubleshooting 124 
erasing 41, 149-150 
initializing 149- 150 
locking/unlocking 125 
restarting from I 17 
troubleshooting 122 
working with 40-41 

Folders 
creating 41 
dragging items co 27 
icons for 34 
linking for synchronization 138-139 
menus of 39 
naming 26 
opening 27, 39 
opening higher levels of 37 
placing icons inside 41 
saving documents in 26-27, 39 
storing work in 26-27 
synchronizing between PowerBook 

and deskcop Macintosh 
137-146 

Fonts, troubleshooting 126 
Format, disk 148 
Formatting DOS-format disks 149- 150 
Function keys 43 

H 

Hands, discomfort in 5 .I 
Hard disk 

as startup disk 129 
built-in cerrninator for 90 
copying contents of to floppy disk 40 
copying floppy disk contents to 40 
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deleting items from 28-29, 36 
external 129 
install ing system software on 

129- 136 
power consumption of 71 
spinning down 59, 71 
storing documents on 23-24 
troubleshooting 122, 129 
turning off when not in use 59 
using PowerBook as 93-95 

Hard disk icon 20, 34 
Hard disk sleep, controlling 71 
Hard disk windows. See wi ndows 
HD Spin Down module (Control 

Strip) 59 
HDI-30 SCSI Disk Adapter 93 
HDI-30 SCSI System Cable 87, 9 l- 92 
Headphones 105, 109 
Health-related information 48-52 
Help menu 42, 53 
Hiding and showing Control Strip 55 
Highlighted commands 42 
Highlighting text 24 

I, J 

I-beam pointer 83 
Icons 34-36 

Apple HD SC Setup 133 
blinking in menu bar 120 
blinking question mark 5, 129, 134 
copying 35 
deselecting 34 
Disk First Aid 131, 133 
Disk Tools 130, 133 
DOS-format disks 148 
dragging to Trash 28 
folder icons 34 
hard disk icon 20, 34 
lightning bolt 65 
moving 35 
naming and renaming 35 
opening 35 

placing inside folders 41 
PowerBook F ile Assistant 138 
puning away 36 
RAM disk 79 
recovering from Trash 29 
removing with Trash 28, 36 
SCSI 94 
SCSI port 87 
selecting groups of 34 
selecting lists of 34 
Trash 28-29 
video port icon 99, 104 
working with 34 

ID numbers. See SCSI ID number 
Initializing DOS-format disks 149-150 
Install Me First disk 130-131, 134-135 
Installer 130-13 l, 134-135 
Installing 

PowerBook File Assistant 138 
software drivers 88 
system software 129-136 

Internal hard disk. See hard disk 
Internal modem. See modem, internal 
International power requirements 85 

K 

Keyboard 
angle of 51 
position of 50 
special keys on 43 

Keyboard shortcuts 42 
Keys, special 43 

L 

Laser printer 
networks and 84 

Lightning bolt icon 65 
Locked disks 125 
Locked files 124 
Lotus 1-2-3 version 1.0 (Windows) 154 
Low-power messages 64 



M 

Macintosh 
opening DOS documents on 151 
synchronizing files between 

PowerBook and desktop 
Macintosh 137 

synchronizing files with 137-145 
Macintosh Basics tour 9-10, 12-15 
Macintosh PC Exchange 147- 148, 

152- 163 
assigning Mac programs to DOS 

151-158. 160- 161 
control panel 

adding assignments to 152, 
157- 158 

editing assigment lists L60 
trying out assignments in 160 

opening DOS documents with 151 
Preferences file 161 
purpose of 147 
saving documents onto DOS disks 

with 161-162 
Macintosh programs, assigning to DOS 

documents 152-163 
MacTCP 112 
Maintenance 45 
Memory 

insufficient amount of 121 
persistent RAM 75 
protecting contents of 64 
upgrading 1 I 0 
virtual memory 69, 110 

Memory control panel 78-81 
Menu bar 30 

blinking icon in 120 
displaying on external monitor JO 1 

Menus, working with 42 
Messages. See alert messages; error 

messages: low-power messages 
Microphone 109 
Microprocessor, processor cycling 

and 73 

Microsoft Excel 3.0 (Windows) 155 
Microsoft Word 2.0 (Windows) 155 
Modem, external 

connecting I 06-107 
troubleshooting 125 

Modem, internal I 06-107 
power consumption of 69 
troubleshooting 125 

Modem/Printer port I 05 
Modules 53 
Monitor. external 97-104. See also 

screen 
activating 100 
as extension of PowerBook screen 97 
connecting 98 
disconnecting I 04 
displaying menu bar on JOI 
position of 98 
power adapter and 98 
presentations and 103 
troubleshooting 122 
trouble with I 00 
working with 102-103 

Monitors control panel 100-101 
Mouse 

adjusting tracking speed of 83 
adjusting track length of 83 
connecting I 08 
position of 5 1 

Moving 
Control Strip 56 
icons 35 
pointer with Trackpad I 0 

Musculoskeletal discomfort 48-49 

N 

Naming 
documents 23-24, 39 
files for use on both Macintosh and 

DOS computers 162 
folders 26 
icons 35 
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Networking services 111 
Networks 111-114 

AppleTaJk 61-62, 84, 112 
automatically connecting to shared 

disks 75, 77 
Ethernet, connecting to 111-114 
installing system software on 

130, 132 
passwords and 77 
Print Later option 75, 84 
troubleshooting 127 
zones 126-127 

New Folder command (File menu) 
26, 41 

Nickel-metal-hydride (NiMG) batteries. 
See batteries 

0 

Open command (File menu) 38 
Opening 

Control Panels 69 
Control Strip 54 
display 3 
documents 38 
DOS documents on a Macintosh 151 
files 38 
folders 27, 39 
higher levels of folders or disks 37 
icons 35 
Trash 29 
windows 36 

Option key 43 
Overseas power requirements 85 

p 

PageMaker 4.0 (Windows) 155 
Passwords 77 
Persistent RAM disk 75, 78 
Plug adapters 85 

Pointer 
I-beam 83 
improving display of 75, 83 
moving 10 
troubleshooting I 20 

Ports 105 
ADB port 105, 108 
Ethernet port 105, 107, 112, 114 
EtherTalk port 111 
modem/printer port 105- 107 
power adapter port 105 
SCSI port 87, 91, 105, 107 
serial port J 05-107 
sound input port 105, 109 
sound output port 105, 109 
video port 97, 99, 104-105 

PostScript laser printer, networks and 84 
Power 64-70, 72-74. See also batteries; 

Control Strip; power adapter 
AC 63 
ADB devices and 108 
batteries 63-73 
battery charge level, monitoring 64 
battery life, maximizing 68-73 
battery removal or replacement 66, 68 
conserving 59, 63-75, 78 
disconnecting l 
external monitor and 98 
hard disk and 59, 71 
international requirements 85 
low-power messages 64 
management of 63-70, 72-73 
microprocessor and 73 
modem and 69 
screen and 68, 71 
SCSI disk mode and 95 
sources of 63 
troubleshooting 116, 11 8 
virtual memory and 69 

Power adapter 1-2, 57, 63-65, 67, 69 
connecting 1-2 
external monitor and 98 



other adapters, damage from 1, 46, 
65, 109 

plug adapters and 85 
troubleshooting 5 

Power adapter cable 2 
Power adapter port 2, 65, 105 
Power On key 4-5, 43 
Power Settings module (Control Strip) 

58,69, 72-74 
Power source, selecting 74 
Power strip 1, 98 
Power Book Display control panel 103 
PowerBook File Assistant 137-138, 

140- 141, 146 
alert messages in 145 
automatic synchronization with 

144, 146 
installing 138 
linking files or folders with 138, 141 
purpose of 137 
starting 138 
synchronizing linked files or 

folders 143 
PowerBook Setup control panel 93- 94, 

106-107, 125 
Practice session 22-31 
Presentations, external monitor and 103 
Printer 

connecting 107 
connecting directly to with 

Ethernet 114 
network and 84 
troubleshooting 125-126 

Printing on network 84 
Problems. See error messages; 

troubleshooting 
Processor cycling 73 
Programs. See application programs 
Put Away command (File menu) 36 

Q 

Quattro (DOS) 3.0 156 
Quick reference 8, 33-42 
Quit command (Flle menu) 25 
Quiz on basics 16-19 

R 
RAM, protecting contents of 64 
RAM disk 78-82, 121 

as startup disk 69, 75, 82 
losing contents of 79, 116 
persistent RAM 75, 78 
saving contents in System Folder 75 
setting up 78-81 
using 82 

RAM Disk Backup folder 78 
RAM disk icon 79 
Recharging batteries l , 45-47, 63, 

65-66,68 
troubleshooting 119 

Recycling batteries 47, 67 
Removing 

batteries 66-67 
items from hard disk. See Trash 

Renaming icons 35 
Repairing DOS-format disks 148 
Repetitive stress injuries (RSis) 48 
Replacing batteries 67-68 
Reset key combination 6, 116 
Resizing Control Strip 55 
Restart command (Special menu) 

6-7,31 
Restarting the PowerBook 

from floppy disk 1 17 
troubleshooting 116-117 
with reset key combination 6 
withRestartcotnmand 7,3 1 

Return key 43 
Review of basics 16-19 
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s 
Safety instructions 45-47 

for travel 85 
Save command (File menu) 23-24, 39 
Save As command (File menu) 39 
Saving documents 39 

onto a DOS-format disk 162 
troubleshooting 125 

Screen. See also external monitor 
angle of 51 
brightness and contrast of 5, 51 
dimming 68, 71 

on external monitor 102 
external monitor as extension of 97 
power consumption of 68, 71 
troubleshooting 119, 122 

Scroll arrow 21, 36 
Scroll bar 21, 36 
Scroll box 36 
Scrolling windows 25, 36 
SCSI chain 87-88, 90-96 

connecting cables 91-92 
length of 92 
number of devices in 87 
setting SCSI ID numbers for 88-89 
terminating 90 
troubleshooting 121 

SCSI devices 87-96 
connecting 87-96 
definition of 87 
installing software for 88 
troubleshooting 121 
turning on first 92 

SCSI disk, connecting PowerBook as 
93-94 

SCSI Disk Adapter cable 93-95 
SCSI disk mode 93-96 

battery consumption in 95 
connecting PowerBook as a SCSI disk 

93-94 
quitting 95-96 
simplifying connection process 95 

SCSiicon 94 
SCSI ID number, setting 88-89 
SCSI ID number indicator 89 
SCSI ID number switch 89 
SCSI peripheral interface cable 91-92 
SCSI port 87,91, 105, 107 
SCSI port icon 87 
SCSI System Cable 87, 91-92 
SCSI terminators 90 
Selecting icons 34 
Serial port 105-107 
Service and support 86 
Setting up the PowerBook 1-8 
Shared disks 

automatically connecting to 77 
troubleshooting 127 

Sharing files 60 
Shift key 43 
Shortcuts. See keyboard shortcuts 
Show Balloons (Help menu) 53 
Shut Down command (Special menu) 6 
SimpleText program 

opening 22 
quitting 25 

Size box 21 
Sleep 

automatic 7, 64, 68, 71, 119 
battery conservation settings 

corresponding to sleep 71 
controlling 71 
hard disk sleep 71 
prevented by external monitor 102 
putting the PowerBook to 6-7, 59-60 
reconnecting to shared disks after 77 
troubleshooting 119 
waking from 7, 60, 70 

Sleep command (Special menu) 6, 60, 70 
Sleep module (Control Strip) 70 
Sleep Now module (Control Strip) 59 
Software. See application programs; 

Macintosh PC Exchange; 
PowerBook File Assistant; 
system software 



Software drivers, installing 88 
Sound, changing volume of 61 
Sound input devices, connecting 

108-109 
Sound input port 105, 109 
Sound output devices, connecting 109 
Sound output port 105, 109 
Sound Volume module (Control 

Strip) 61 
Speakers, external 109 
Spills 46 
Spinning down hard disk 59, 71 
Starting the PowerBook 4-5, 7, 116, 121 
Startup disk 

floppy disk as 129 
hard disk as 129 
RAM disk as 69, 75, 82 

Startup Disk control panel 81 
Storage folder 135 
Storing documents. See Save command; 

Save As command 
Storing PowerBook 86 
Summary of basic skills 33-42 
Synchronizing PowerBook and desktop 

Macintosh files 137 
System error message 7 
System failures 116 
System Folder 

backing up 130 
System software 129-136 

customized 135-136 
damaged 133 
installing 129-136 
installing customized version of 

135-136 
installing for the first time 130-132 
on a network 130 
purpose of 5, 129 
reinstalling 133-135 
troubleshooting 133 

T 

Tabkey 42 
Temperature range 47, 86 
Text 

highlighting 24 
typing and correcting 23 

Title bar 21, 24 
Tracking speed, changing 76 
Trackpad 

adjusting 76 
button 10, 13 
moving pointer with 10 
position of 50 
tips for using 11 

Trackpad control panel 76 
Transporting 

batteries 85 
PowerBook 85 

Trash 28-29 
bulging 28 
deleting files with 28-29, 36 
dragging items to 28 
ejecting floppy disks with 40 
emptying 29, 36 
opening 29 
recovering items from 29, 36 

Trash icon 29 
Traveling with PowerBook 85 
Troubleshooting 115-128 

application programs 128 
batteries 67, 118-119 
damaged PowerBook 86 
disk drives and disks 122-125 
external monitor 100, 122 
memory 121 
modems 125 
networks 127 
power 5, 118 
PowerBook 116-118 
printers 125-126 
RAM disk 79 
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screen 119-120, 122 
SCSI devices 12 1- 122 
turning the PowerBook on 116, 121 
what to do if you are stuck or lost 31 

Turning external monitor on 100 
Turning SCSI devices on 92 
Turning the PowerBook off 6 

with reset key combination 6 
Turning the PowerBook on 4-5. See also 

restarting the PowerBook 
after system error 7 
troubleshooting 5, 11 6, 121 

Turning video mirroring on and off 
62, 103 

u 
Unlocking 

files 124 
floppy disks 125 

Upgrading memory 110 

v 
Ventura Publisher 3.2 (Windows) 156 
VGA monitors 97. See also monitor, 

external 
Video cable 99 
Video mirroring 62 

later 103 
Video port 97, 99, 104-105 
Video po1t icon 99 
Virtual memory 110, 121 

power consumption of 69 
Volume, changing 61 

w, x, Y, z 
Waking from sleep 6-7, 60-61 , 70 
Warranty, voiding 46 
Windows 36-37 

activating 31 , 37 
closing 3 I, 36 
hidden 120 
opening 36 
purpose of 36 
scrolling 25, 36 
viewing contents of 37 

Windows, Microsoft 
exchanging files with 147 

WordPerfect 5.1 (DOS) 156 
Work environment 48, 50-52 
Wrists, discomfort in 51 



Apple Computer, Inc. 
1 Infinite Loop 

Cupertino, California 95014-6299 
408.996.1010 
TLX 171-576 

030-5786-A 
Printed in U.S.A. 


